
Copyright 1995-2007 Pico Technology Limited. All rights reserved.

 

User's Guide

PSW044 v1.8

PicoScope



PicoScope User GuideI

Copyright 1995-2007 Pico Technology Limited. All rights reserved.PSW044 v1.8

Contents
.............................................................................................11 Introduction 

...................................................................................................11 What is PicoScope? 

...................................................................................................12 Why use PicoScope? 

...................................................................................................23 Screen layout 

...................................................................................................24 Display area 

...................................................................................................35 Customisation 

...................................................................................................36 Exporting data 

...................................................................................................37 Safety 

...................................................................................................48 Legal information 

...................................................................................................59 Company details 

.............................................................................................62 Instrument windows 

...................................................................................................61 Introduction 

...................................................................................................72 Oscilloscope 

...................................................................................................93 Spectrum analyser 

...................................................................................................114 Meter 

...................................................................................................125 XY oscilloscope 

...................................................................................................136 Composite window 

...................................................................................................147 Triggering 

.............................................................................................153 Instrument toolbars 

...................................................................................................151 Introduction 

...................................................................................................152 Default toolbar 

...................................................................................................153 Oscilloscope toolbar 

...................................................................................................164 Spectrum analyser toolbar 

...................................................................................................175 Meter toolbar 

...................................................................................................176 XY oscilloscope toolbar 

...................................................................................................187 Composite window toolbar 

...................................................................................................198 Sampling and trigger toolbar 

.............................................................................................204 Menus 

...................................................................................................201 Introduction 

...................................................................................................202 File menu 

...................................................................................................223 Edit menu 

...................................................................................................224 Settings menu 

...................................................................................................245 View menu 

...................................................................................................256 Window menu 

...................................................................................................257 Help menu 

...................................................................................................258 Keyboard shortcuts 

.............................................................................................275 Dialog boxes 



IIContents

Copyright 1995-2007 Pico Technology Limited. All rights reserved. PSW044 v1.8

...................................................................................................271 General 

...................................................................................................312 Channel configuration 

...................................................................................................363 Measurement setup 

...................................................................................................444 Custom range settings 

...................................................................................................475 ADC setup 

...................................................................................................506 Oscilloscope configuration 

...................................................................................................557 Spectrum analyser configuration 

...................................................................................................578 XY scope configuration 

...................................................................................................589 Meter configuration 

...................................................................................................6110 Composite setup 

.............................................................................................636 Common tasks 

...................................................................................................631 Adding a custom range 

...................................................................................................632 Adding a ruler 

...................................................................................................643 Repositioning a ruler 

...................................................................................................644 Removing a ruler 

...................................................................................................645 Adding a test menu 

...................................................................................................656 Changing axis scaling 

...................................................................................................657 Changing the footer on printed graphs 

...................................................................................................658 Changing settings 

...................................................................................................659 Configuring your oscilloscope 

...................................................................................................6610 Converting data files to text 

...................................................................................................6611 Opening an instrument window, or view 

...................................................................................................6712 Displaying measurements 

...................................................................................................6713 Printing the contents of a window 

...................................................................................................6714 Exporting to a word processor 

...................................................................................................6715 Exporting to a spreadsheet 

...................................................................................................6816 Removing an offset 

...................................................................................................6817 Selecting x10 probes 

...................................................................................................6818 Switching to ETS mode 

.............................................................................................707 Technical reference 

...................................................................................................701 Introduction 

...................................................................................................702 Dynamic Data Exchange 

...................................................................................................703 Initialisation settings 

...................................................................................................734 File and clipboard formats 

...................................................................................................745 Signal conditioner files 

...................................................................................................746 Autosetup 

...................................................................................................757 Test menus 

...................................................................................................778 Glossary 

......................................................................................................81Index



PicoScope User Guide1

Copyright 1995-2007 Pico Technology Limited. All rights reserved.PSW044 v1.8

1 Introduction
1.1 What is PicoScope?

PicoScope is a software application enabling you to use your PC to display voltage
waveforms. Used in conjunction with a Pico Technology oscilloscope, PicoScope
becomes a powerful tool for recording, processing and displaying a wide range of
measurements. The software provides four types of display:

  Oscilloscope
  Spectrum analyser
  Meter
  XY oscilloscope

These displays can be used singly or, using the composite window feature, in any
combination.

1.2 Why use PicoScope?

Used in place of a number of expensive and bulky items of test equipment, PicoScope
saves you money, and keeps your workbench clear for important projects.

Switching between instruments is easy, as the PicoScope instruments are entirely
software-controlled - all you need to do is use a mouse to point and click, and the Pico
Technology oscilloscope stays running all the time. 

These are some of the features supported by PicoScope:

  Auto-ranging
  On-screen display of voltages and times
  Printing, saving and restoring of traces
  Custom measuring ranges
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1.3 Screen layout

The PicoScope application window is divided into the following three areas:

  Display area
Used to display the instrument windows containing the data read from the
oscilloscope. 

  Instrument toolbar 
Located at the top of the screen, this provides the most commonly used controls for
the active instrument window. Each instrument window has its own toolbar and
controls.

  Sample toolbar
Positioned along the bottom of the window, this toolbar shows the current sampling
status and provides controls for triggering.

1.4 Display area

The display area is the central area of the screen. It can contain a number of instrument
windows, each showing test data in a different way. You might want to repeatedly use the
same set of instrument windows. To save a particular window arrangement, you can
choose any of the following options:

  Save to a data file. This will have a file extension of PSD. You can then re-load the file
to see the data again

  Save to a setup file. This will have a file extension of PSS. You can then re-load the
file to use the same settings, but without the data. Read in more data using the same
settings

  Use the Save settings function. The next time you run PicoScope it will start up with
the same windows and settings loaded
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  Save the data for a particular window in TXT format, suitable for importing into Excel,
and WMF, JPG and BMP format, suitable for importing into desktop publishing
applications

1.5 Customisation

You can customise PicoScope in several ways:

By accessing Setup in the File menu.
By adding a menu of standard tests or examples.
By adding custom ranges in units other than volts. For example, you might want to use
pressure units.

1.6 Exporting data

You can use the standard Windows clipboard to export data from PicoScope to other
applications. 

If you want to export PicoScope data to a word processor, you will probably require the
data to be in graphical format so it appears in your document as a picture. For
spreadsheet export, you should use text format so that you can later manipulate the data.

You can use dynamic data exchange to continuously update the data in another
application. The easiest way to do this is to select Paste link from the Edit menu of the
target application.

When you use the clipboard to copy text data, it copies only the data that is displayed.
This will be affected by the X multiplier and by the maximum number of points that can be
displayed. If you wish to transfer all readings to another application, use the Save As

option in the File menu and save the contents of the active window as a text file.

You can also use the Save As option in the File menu to save the contents of the active
window in graphical format as a WMF, JPG or BMP file.

For details of file formats, see File and clipboard formats.

1.7 Safety

We strongly recommend that you read the general safety information in your installation
guide and also the product-specific safety warning in the product manual before using
your product for the first time.
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1.8 Legal information

The material contained in this release is licensed, not sold. Pico Technology Limited
grants a licence to the person who installs this software, subject to the conditions listed
below.

Access

The licensee agrees to allow access to this software only to persons who have been
informed of these conditions and agree to abide by them.

Usage

The software in this release is for use only with Pico products or with data collected using
Pico products.

Copyright

Pico Technology Limited claims the copyright of, and retains the rights to, all material
(software, documents etc) contained in this release. You may copy and distribute the
entire release in its original state, but must not copy individual items within the release
other than for backup purposes.

Liability

Pico Technology and its agents shall not be liable for any loss, damage or injury,
howsoever caused, related to the use of Pico Technology equipment or software, unless
excluded by statute.

Fitness for purpose

No two applications are the same: Pico Technology cannot guarantee that its equipment
or software is suitable for a given application. It is your responsibility, therefore,  to ensure
that the product is suitable for your application.

Mission-critical applications

This software is intended for use on a computer that may be running other software
products. For this reason, one of the conditions of the licence is that it excludes use in
mission-critical applications, for example life support systems.

Viruses

This software was continuously monitored for viruses during production, but you are
responsible for virus-checking the software once it is installed.

Support

If you are dissatisfied with the performance of this software, please contact our technical
support staff, who will try to fix the problem within a reasonable time. If you are still
dissatisfied, please return the product and software to your supplier within 28 days of
purchase for a full refund.

Upgrades

We provide upgrades, free of charge, from our web site at www.picotech.com. We
reserve the right to charge for updates or replacements sent out on physical media.

Trade marks

Windows and Excel are either trademarks or registered trademarks of Microsoft
Corporation. Quattro is a registered trademark of Corel Corporation. Pico Technology
Limited, DrDAQ and PicoScope are internationally registered trademarks.
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1.9 Company details

Address: 

Pico Technology Limited
The Mill House
Cambridge Street
St Neots
Cambridgeshire
PE19 1QB
United Kingdom

Phone:
Fax:

 +44 (0) 1480 396 395 
 +44 (0) 1480 396 296 

Sales

sales@picotech.com

Technical Support

support@picotech.com

Web site

www.picotech.com

mailto:sales@picotech.com
mailto:support@picotech.com
http://www.picotech.com
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2 Instrument windows
2.1 Introduction

The core components of PicoScope are the instrument windows. 

Oscilloscope window.  A PC oscilloscope with all of the features of a modern storage
oscilloscope.

Spectrum analyser window.  Displays power at each of a range of frequencies.

Meter window.  Displays DC voltage, AC voltage, frequency or dB.

XY oscilloscope window.  Displays one channel against another, for instance to
produce Lissajous figures, or for phase analysis.

Composite window.  Displays the contents of up to four other windows within a
single, composite window.

Multiple windows

You can have several windows open in the display area, though PicoScope will run slowly
if you have too many. If PicoScope gets too cluttered, you can easily close down
individual windows, or close all windows, from the Window menu. Alternatively, you can
rearrange the windows, or minimise them then reinstate them when you need them.

If you have more than one instrument window, it is worthwhile changing the title of the
windows to indicate what type of data they contain - you can set the title using the Options

dialog box for the window, for example, the Scope Options dialog box. The title appears
on the bar at the top of the instrument window, on print-outs of instrument windows, in
the Window menu, and on minimised instrument windows.

One of the windows in the display area is the active window (the bar at the top of the
window is highlighted). You can switch between windows using the methods common to
most Windows applications. For example, to activate a window, click its title bar.

You can change the settings for data collection or display for any window, but you must
first activate it. The commonly used settings for the active window are displayed on the
instrument toolbar at the top of the display. To inspect or change the remaining settings,
access the Settings menu on the menu bar.

Zoom multipliers

Some instrument windows allow you to zoom in on a small area of the display by setting
the multiplier for X or Y axis, or both, to a value other than one. With the multiplier
switched off, PicoScope shows you all of the data in the window. With the multiplier set to
x1, PicoScope initially shows you all of the data, but you can move the data up and down
with the scroll bar provided. This is useful if you wish to separate two traces with similar
voltages. With the multiplier set to x2, PicoScope shows you only half of the data but the
scroll bar enables you select which half you can see.  You can also control X-axis
zooming using the mouse (see under oscilloscope toolbar and XY oscilloscope toolbar for
details).

Time, date and notes

The computer adds the date and time to each window and you can also add notes of your
own.
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Printing and exporting

You can print out the contents of windows, or write them to the clipboard or to files in
graphical or text form.

2.2 Oscilloscope

The oscilloscope window in PicoScope contains the PC oscilloscope. When the
oscilloscope window is active, the Oscilloscope toolbar is displayed at the top of the
screen.

Timebase

The Scope Timebase dialog box controls the time interval across the oscilloscope display.
Like a conventional oscilloscope, it is normally specified as a time per division. There are
ten divisions across the screen, so the total time interval is ten times the timebase. If you
are not accustomed to using a conventional oscilloscope, you may find it easier to specify
the timebase as a time per scan (see the Scope Advanced Options dialog box.)  You can
zoom in using the toolbar or the mouse.

Channels

For multi-channel oscilloscopes, you can select which channels to display on the
oscilloscope. With two channels, each channel has a separate axis and each trace and
its axis are displayed in a different colour.

Voltage range

If you use PicoScope with oscilloscopes from the ADC-100, ADC-200 or PicoScope 2000
and 3000 series, it is possible to adjust the input voltage range. The Auto option is useful
if you are switching between different, but consistent, signals.

If the input voltage exceeds the chosen range, an overvoltage warning symbol  will
appear on the voltage axis.

You can also add custom ranges so that the values are displayed in some other
oscilloscopes, for example pressure or acceleration.
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AC/DC

If you use PicoScope with oscilloscopes from the ADC-200 and PicoScope 2000 and
3000 series, the AC/DC switches are software-selectable.

Grid

PicoScope displays a 10x10 grid. You can turn this grid off if it obscures important
information: select Settings | Options | Advanced and untick the Display a grid tick box.

Rulers

You can add either horizontal or vertical rulers to the graph using the mouse buttons.
PicoScope reports the exact position of each ruler, and the difference between two rulers
on the same axis.

Display types

The oscilloscope window can show you various combinations of the current data, the
minimum, maximum and average of successive cycles. It can accumulate successive
cycles on the screen. Note that it is not possible to print out an accumulated trace.

Measurements

PicoScope can take over 20 different measurements, using either the whole trace, the
section between the cursors or the cycle around one cursor. You can select any
combination of measurements, and specify alarm limits (error limits) for each measure.
The current value and various statistical measures (mean, standard deviation, etc) are
displayed underneath the trace.

Slow sampling

When the time per scan is more than a second, the computer can work in three ways:

  Standard mode

It collects and displays the data for a complete scan, then starts again collecting and
displaying the data for another complete scan

  Chart recorder mode

It collects data continuously and displays the most data for the most recent scan
interval. Note: Chart recorder mode is not compatible with trigger modes other than 
None

  Block mode

It collects a block of data (no display update during collection) and then displays the
whole block at once. There is no limit to the maximum number of samples, and there
will not be gaps while the display is updated

Note: In standard and chart recorder modes, the sampling is controlled by the computer
and the maximum it can collect is one sample per millisecond. In addition, there may be
gaps in the sampling while the display is updated.  See also: Configuring your
oscilloscope.

ETS

Some products support ETS (Equivalent Time Sampling.) This offers a higher effective
sampling rate when used with repetitive signals. Note that ETS should not be used for
one-shot or non-repetitive signals.

When accessed using the ETS option in the sampling and trigger toolbar, some new,
faster timebases are added to the instrument toolbar.
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2.3 Spectrum analyser

The spectrum analyser window in PicoScope contains the spectrum analyser instrument.
When the spectrum analyser window is active, the Spectrum analyser toolbar is displayed
at the top of the screen.

The spectrum analyser window uses a FFT to convert a set of samples taken at fixed
time intervals into a distribution showing the amount of energy in each of a number of
frequency bands up to a maximum frequency. The maximum frequency is half the
frequency corresponding to the sampling rate.

Like all digital signal analysis tools, PicoScope may give misleading results due to 
aliasing. Where possible, PicoScope uses oversampling to reduce aliasing effects.

Maximum frequency

PicoScope collects data to display a spectrum up to a certain maximum frequency. You
can then display the spectrum for any range of frequencies up to this limit. The higher the
frequency, however, the wider the interval between spectrum frequencies. Set the
maximum frequency using the Spectrum Timebase dialog box or the Spectrum analyser
toolbar.

Note: PicoScope needs to collect a large, contiguous block of data for spectrum analysis.
If you specify a very low maximum frequency, this will take a long time to collect for some
products: PicoScope prevents normal Windows® operation during this data collection.

Y axis scaling

On the spectrum display, the Y axis represents the power at a specified frequency. The
power can be expressed either as volts (RMS), or as dB. Set the Y axis scaling using the
Spectrum Options dialog box.

X axis scaling

The X axis represents frequency. You can display the frequency either in linear or in
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logarithmic form. Set the X axis scaling using the Spectrum Options dialog box.

Voltage range

The spectrum display may give confusing results if the signal exceeds the input voltage
range: under most circumstances, we strongly advise using the Auto voltage range. If the
signal is variable or intermittent, it may be advisable to use an oscilloscope window to
determine the maximum required voltage range, and then fix the spectrum voltage range
at that level.

Display type

In addition to displaying the current spectrum, you can also display the average or the
peak value of successive cycles.

Windowing

PicoScope performs an analysis on a relatively short block of samples. The 'cutting' of
this block from the data stream can introduce distortion which produces side-lobes on
spectrum peaks. This effect can be reduced by multiplying the block of data by a set of
factors which 'rounds off' the ends of the data. This technique is known as windowing.

PicoScope supports several different windowing methods: no windowing algorithm is
guaranteed to eliminate all end effects, but switching between two methods can give a
clue whether a particular peak is a side-lobe or a genuine peak. For general use, we
recommend the Blackman window. Select a window type using the Spectrum Options

dialog box.

Grid

PicoScope displays a 10x10 grid. You can turn this grid off if it obscures important
information.

Ruler

You can use the mouse buttons to add a ruler to the spectrum analyser window. The
computer displays the frequency at the current ruler position, and the amplitude of each
trace at that frequency.
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2.4 Meter

The meter window contains the meter, an instrument that displays readings in real time in
any of the following units:

  DC volts
  AC volts
  dB
  Hz

If you add one or more custom ranges, the meter can also display values in some other
units, for example pressure or acceleration.

The meter window comes in two forms. The simplest form displays a single number and
an optional bar graph. The number is one parameter measured on one channel, for
example AC volts on channel A. 

The more advanced form of meter window displays a set of numbers. These can be a
selection of parameters from a selection of channels. An asterisk indicates the active
parameter.

Note: When you use the oscilloscope in standard or chart recorder mode, with a timebase
of less than 200 ms/div, meter readings are not updated.
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2.5 XY oscilloscope

When the active window is an XY oscilloscope, the XY oscilloscope toolbar is displayed
at the top of the screen.

Timebase

The XY Timebase controls the time interval for each scan. Ideally, it should be a little
longer than a single cycle of the signal that you wish to observe.  You can zoom in using
the toolbar or the mouse.

Voltage range

If you use PicoScope with oscilloscopes from the ADC-100, ADC-200, PicoScope 2000 or
3000 series, you can adjust the input voltage range. The Auto option is useful if you are
switching between different, but consistent, signals. You can also add custom ranges so
that the values are displayed in other units, such as pressure or acceleration units.

If the input voltage exceeds the chosen range, an overvoltage warning symbol  will
appear on the corresponding axis.

Accumulate

If the waveform you are displaying is periodic with only minor fluctuations, you can select 
Accumulate successive cycles. This is a tickbox on the Options menu in Settings. The
computer then draws new traces on top of the old ones, so that any unusual traces - for
instance, glitches and missing pulses - stand out.

Grid

By default, PicoScope displays a 10x10 grid. You can turn this grid off if it obscures
important information.



PicoScope User Guide13

Copyright 1995-2007 Pico Technology Limited. All rights reserved.PSW044 v1.8

Rulers

You can add either horizontal or vertical rulers to the graph using the mouse buttons.
PicoScope reports the exact position of each ruler, and the difference between two rulers
on the same axis.

2.6 Composite window

The composite window allows you to display the contents of up to four instrument
windows at any one time in the same window. This is particularly useful when you want to
compare screen traces, or print out the contents of more than one window on the same
page.

You can control what combination of window data is displayed in the composite window,
and in what order it is displayed. The following options - accessed from the Layout

drop-down list in the Options... menu in Settings - are available for the composite window:  

  Auto select

Select whichever format is appropriate, based on what the windows have in common
 

  Overlay views

Useful if you wish to compare two versions of traces taken with the same
measurement and scaling parameters

  Side by side (max 2)

  Allows you to compare two traces with the same amplitude

  One above another (max 4)

Useful if you need to collate the X (time or frequency) axis for several signals. The
maximum amount of window data you can display is four sets

  2x2 square (max 4)

Display up to four sets of window data in a square



Instrument windows 14

Copyright 1995-2007 Pico Technology Limited. All rights reserved. PSW044 v1.8

2.7 Triggering

For oscilloscope and spectrum analyser windows, it is possible to specify a trigger event
for collecting the block of data. The block of data can be collected immediately after the
trigger event, or it can be a specified delay (expressed as a percentage of the scan time)
after the trigger event. A negative trigger delay means that part or all of the data block is
before the trigger event.

The trigger event occurs when the signal level for the specified channel crosses a
threshold. It is possible to select whether the event is a rising or a falling as it crosses the
threshold. The following diagram shows a rising trigger event, with a delay of -20%.

If the trigger event occurs only once, it is useful to be able to stop immediately after
collecting the data for the trigger event. You can do this by checking the Stop after trigger

option in the Trigger dialog box, or by setting the trigger mode to Single in the Sampler and
trigger toolbar.

Note: If you turn off auto-trigger when using a product other than an oscilloscope from the
ADC-200 and PicoScope 2000 and 3000 series, PicoScope locks the computer until a
trigger event occurs. If PicoScope does become stuck, click on the Stop button in the
Sampler / trigger toolbar, then press F9 (16-bit applications) or F10 (32-bit applications)
to cancel the trigger.

If a particular event only occurs very occasionally, it is useful to leave PicoScope running
with the Save on trigger option set. Each time a trigger event occurs, the data is written to a
sequence-numbered file. You can later examine the data using the page up and page
down keys to take you through the sequence of recorded events.

The same trigger settings apply to all instrument windows.
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3 Instrument toolbars
3.1 Introduction

The instrument toolbars are displayed at the top of the main window, just underneath the
menu bar. Which instrument toolbar is displayed depends on which instrument window is
currently active.

3.2 Default toolbar

The default toolbar appears when there are no active windows.

 Click this button to open a new oscilloscope window

 Click this button to open a new spectrum analyser window

 Click this button to open a new meter window.

3.3 Oscilloscope toolbar

The oscilloscope toolbar appears when the oscilloscope window is active.

Light.  The PicoScope 2104 and 2105 variants have a light built in
to the probe tip.  Click this button to switch the light on and off.

Autosetup.  The program searches for signals on all enabled
channels, and adjusts the timebase and ranges accordingly.  It
does not change the AC/DC or On/Off status of any channel.  For
further details, see Autosetup.

Timebase.  The length of time represented by each division (grid
square) horizontally.

X Multiplier.  A horizontal scaling factor. Use it to zoom in after
capturing data.  You can also zoom in using mouse zooming: hold
down the Ctrl key whilst drawing a vertical line downwards with the
mouse. The program will select a zoom factor between x2 and
x200 according to the length of the line.  To zoom out to x2, hold
down the Ctrl key and draw a vertical line upwards with the
mouse.  When you are zoomed in, you can scroll left and right by
dragging the scrollbar, or by holding the Ctrl key and pressing the
left and right arrow keys.
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Channel A

Range.  The maximum voltage that the oscilloscope will measure
without error.  A warning symbol ( ) will appear if the input
exceeds this voltage.  

(Tip: Set the range just above the maximum voltage you expect to
measure.  Setting it unnecessarily high will reduce the accuracy of
your measurements.)

AC/DC select (ADC-200 and PicoScope 2000 and 3000 series
oscilloscopes only). This selects the coupling circuit used in the
oscilloscope's input. 

(Tip: Set to DC if you need to measure the absolute value of a
voltage. Set to AC if you only want to measure the amplitude of a
signal, such as its peak-to-peak value, without regard to its
absolute DC value.)

Y Multiplier.  A vertical scaling factor. Use it to zoom in after
capturing data.

Channels B, C, D

See Channel A. The number of channels available depends on the oscilloscope variant
you are using.  

Channel Y

On single-channel oscilloscopes, the vertical channel is called Y.

3.4 Spectrum analyser toolbar

The spectrum analyser toolbar appears when the spectrum analyser window is active.

Maximum Frequency. The frequency at the right-hand end of
the frequency scale.

X Multiplier. A horizontal scale factor. Use to zoom in on
captured data.

Spectrum 1

Channel. The input channel that Spectrum 1 represents. The
number of channels available depends on the oscilloscope
variant that you are using.
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Range. The maximum voltage that the oscilloscope will
measure without error.  A warning symbol ( ) will appear if the
input exceeds this voltage.  

(Tip: Set the range just above the maximum voltage you expect
to measure.  Setting it unnecessarily high will reduce the
accuracy of your measurements.)

AC/DC Select (ADC-100/200 and PicoScope 2000 and 3000 
series oscilloscopes only). This selects the coupling circuit used
in the oscilloscope's input. 

(Tip: Set to DC if you need to measure the absolute value of a
voltage. Set to AC if you only want to measure the amplitude of
a signal, such as its peak-to-peak value, without regard to its
absolute DC value.)

Spectrum 2

See Spectrum 1.

3.5 Meter toolbar

The meter toolbar appears when the meter window is active.. For multi-parameter
windows, the current parameter is marked with an asterisk.

Channel. Selects the channel (1, 2, 3 or 4) that the meter will measure.
The number of channels available depends on the oscilloscope variant
that you are using.

Function. AC volts, DC volts, decibels or hertz.

Voltage Range. The maximum voltage that the oscilloscope will
measure without error.  A warning symbol ( ) will appear if the input
exceeds this voltage.  

(Tip: Set the range just above the maximum voltage you expect to
measure.  Setting it unnecessarily high will reduce the accuracy of your
measurements.)

3.6 XY oscilloscope toolbar

The XY oscilloscope toolbar appears when the XY oscilloscope window is active.

Timebase.  The time between display updates.
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X Channel

Range.  The voltage range that corresponds to the width of the
screen. A warning symbol ( ) will appear if the input exceeds
this voltage.  

(Tip: Set the range just above the maximum voltage you expect
to measure.  Setting it unnecessarily high will reduce the
accuracy of your measurements.)

AC/DC Select (ADC-200 and PicoScope 2000 and 3000 series
oscilloscopes only). This selects the coupling circuit used in the
oscilloscope's input. 

(Tip: Set to DC if you need to measure the absolute value of a
voltage. Set to AC if you only want to measure the amplitude of
a signal, such as its peak-to-peak value, without regard to its
absolute DC value.)

Multiplier. The horizontal scaling factor. Set to "Off" when
capturing data, then change to zoom in.  You can also zoom in
using mouse zooming: hold down the Ctrl key whilst drawing a
vertical line downwards with the mouse. The program will select
a zoom factor between x2 and x200 according to the length of
the line.  To zoom out to x2, hold down the Ctrl key and draw a
vertical line upwards with the mouse.  When you are zoomed in,
you can scroll left and right by dragging the scrollbar, or by
holding the Ctrl key and pressing the left and right arrow keys.

Y Channel

Range. The voltage range that corresponds to the height of the
screen. See X Channel for more details.

AC/DC Select. See X Channel.

Multiplier. The vertical scaling factor. Set to "Off" when
capturing data, then change to zoom in.  

3.7 Composite window toolbar

The composite window toolbar appears when the composite window is active.

X multiplier for composite window

Y multiplier for composite window
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3.8 Sampling and trigger toolbar

The sampling / trigger toolbar provides three main functions:

  Start/stop sampling
  Display current sampling status
  Set trigger

Start and stop sampling

Sampling Status

Trigger Mode.

Trigger Channel

Trigger Direction

Trigger Threshold

Trigger Delay
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4 Menus
4.1 Introduction

The following menus are accessible from the menu bar (see below) in PicoScope:

 File

 Edit

 Settings

 View

 Window

 Help

4.2 File menu

New

This menu option clears the display area. 

Open...

This menu option closes all display windows and then opens a data or setup file. 
If you open a data file, the settings and data are copied from the file and the data is
displayed. 
If you open a setup file, only the settings are recovered. No data is displayed until you
start PicoScope running.

Merge

This menu option reads data saved from a previous session and displays it in a new
window.  It leaves open any existing windows in the display area.

Save

This menu option saves the contents of the display area in the same file as last time. If
the contents of the display area has not been saved yet, it asks for a filename.  See File
and clipboard formats for more details.
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Save As...

This menu option asks for a filename and then writes the contents of the display area or
the active window to a file.

If you save the contents of the display area in a setup file, only the settings are stored.  If
you save the contents of the display area to a Data file, both settings and data are stored.

You can also save the contents of the active window as a text file .txt, or as a .wmf, .jpg
or .bmp image.  See File and clipboard formats for more details.

Open next
Open previous

When you use the Save on trigger option, PicoScope saves tests in sequentially numbered
files. Once you have read in one file in a sequence, you can use the Open Next/Open
Previous options to load the next or the previous file in the sequence.

Print...

This menu option is used to print the contents of the active window or all windows. If you
select all windows, the contents of each window is printed on a separate page.

Save Settings

This menu option saves the current arrangement of windows in the display area to a
special file called settings.pss. This will be loaded automatically next time you run
PicoScope.

Setup

 
Converter 

For specifying the converter type and printer port.
Display

For choosing from various display options, for example display
timestamp and notes.
Colours

For specifying the trace colours and trace width.

Exit

This menu option enables you to exit from the program.
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4.3 Edit menu

Copy as Text

This menu option copies the data for the active window to the clipboard, in text format.
This is useful if you wish to transfer the data to a spreadsheet for analysis. You can
simply copy the data once, or create a DDE link so that the data is updated continuously
in the target application.

Copy as Graph

This menu option copies the data for the active window to the clipboard, in graphical
format, exactly as it appears on the screen. This is useful if you wish to transfer the data
to a Word Processor or graphical package, so that you can incorporate the data from the
window into a document.

Copy measurements

This menu option copies the data for any measurements selected in the active window, in
text format, as tab separated values. This is useful if you wish to transfer the data to a
spreadsheet.

Duplicate view

This menu option creates a new window with the same settings as the active window,
then stops the old active window. If you then create a composite containing the contents
of old and new windows, you can overlay the two traces, so that you can compare the
current trace with the old trace.

4.4 Settings menu

Timebase...

This menu option enables you to set the timebase for the following facilities:
  Oscilloscope
  Spectrum analyser
  XY oscilloscope

 

Channels...

This option is used to select the channels for the active window.
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Trigger...

This option is used to set the parameters for the trigger event.

Options...

This menu option enables you to specify the various options for the active window. The
options depend upon the type of window. Each of the following facilities has a separate
window, and therefore a separate set of options:

  Oscilloscope
  Spectrum analyser
  Meter
  XY oscilloscope
  Composite

Notes...

This option can be used to enter some brief notes that will be displayed on the active
window.

Measurements

This option is used to specify a number of measurements to be displayed at the bottom of
the oscilloscope trace.

Signal Generator...

This menu option is used to set the signal generator frequency if you are using an
oscilloscope from the ADC-200 or PicoScope 2000 or 3000 series.

Custom Ranges

This option is used to define alternative ranges so that traces can be displayed in some
units other than volts. 

Probes

This group of menu options enables you to specify whether you are using x1, x10, x20 or
x100 probes. If you select x10, the range selections on the instrument toolbar do not
change, but all displayed values are multiplied by 10.

Offset null...

When operating at the most sensitive input voltage ranges, there may be a small offset
(perhaps a few millivolts) on the voltage readings. 

To remove this offset, disconnect or short the input for a channel, select this option and
then select the channel. PicoScope measures the voltage on the channel and then
removes this offset. The offset is not stored, so it is necessary to repeat this procedure
each time you start PicoScope.
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4.5 View menu

New Scope

This menu option creates a new Oscilloscope window.
 

New Spectrum

This menu option creates a new Spectrum analyser window.

New Meter

This menu option creates a new Meter window.

New XY scope

This menu option creates a new XY oscilloscope window.

New Composite

This menu option creates a new Composite window. If there are four windows or fewer in
the display area, all the windows are added to the composite.

Run/stop all

This menu option starts or stops data collection on all windows that are not frozen. You
can also do this by pressing the space bar or by using the mouse to click on the Run/Stop
button at the bottom left of the window. 

Run/stop view

This menu option starts or stops the active window. If the window is currently frozen, it
both thaws and starts the window.

Freeze/thaw one

This menu option freezes or thaws the active window. When a window is frozen, it is
stopped and will not start even if the Run/Stop button is pressed.

Clear

This menu clears the active window. This means that it eliminates the data, while leaving
the settings the same.

Close

This menu option closes the active window.
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4.6 Window menu

Tile

This menu option arranges all of the windows so that they are equally spaced over the
main window.
 

Cascade

This menu option arranges all of the windows so that only the title bar of each window is
visible.

Arrange Icons

If you have several windows displayed as icons, this menu option arranges the icons
along the bottom of the main window.

Close all

This menu option close all windows, leaving the display area empty.

4.7 Help menu

Index

This menu option takes you to the index of this manual.
 

Contents

This option takes you to the contents page of this manual.

Using help

This option leads to an explanation of how to use Windows help

About...

This option shows details about the PicoScope program and the driver you are currently
using.

4.8 Keyboard shortcuts

Key Function Explanation

PgDn Open next When you have used the "save on trigger" option to
save a series of waveforms, this command lets you
step forward through the series.

PgUp Open previous Step backward (see Open next).

F1 Help index View the PicoScope online help index.
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F2 Timebase... Set up the scope timebase, spectrum timebase or
XY timebase.

F3 Channels... Select and configure the input channels.

F4 Trigger... Set up the trigger 

F5 Options... Set miscellaneous options for the current view.

F6 Notes... Type a note to appear in the current view.

F7 Signal Generator... Set up the signal generator (if your oscilloscope
has one).

F9 Run/stop all Pause or resume sampling in all non-frozen
windows.

F10 Run/stop all As above.

Space Run/stop all As above.

Ctrl-F4 Close Close the current view.

Ctrl+Left Scroll left Scroll waveform left in oscilloscope and XY
oscilloscope views, when horizontally zoomed.

Ctrl+Right Scroll right See Scroll left.

Ctrl+Mouse Horizontal zoom Zoom horizontally by drawing vertical line with
mouse.  For downward line, zoom factor varies
from x2 to x200 depending on length of line.  For
upward line, zoom factor is set to x2.
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5 Dialog boxes
5.1 General

5.1.1 Trigger setup

From the Settings menu, select Trigger....

The trigger facility allows you to specify a point in time when PicoScope will begin
collecting data for display. This is usually at some fixed time before or after a trigger
event. The current settings for the trigger apply to all windows (ie there is not a separate
set of trigger settings for each window).

A trigger event occurs when a specified channel crosses a voltage threshold (rising or
falling). PicoScope can start collecting data immediately after the trigger event or at a
fixed time interval before or after the trigger event. 
 
After PicoScope has collected a block of data and displayed it, PicoScope can either start
looking for the next trigger event, or stop collecting, leaving the data after the trigger on
the display.

Trigger enabled

When this box is checked, PicoScope only collects data when the specified trigger
conditions occur. If the box is not checked, it displays data continuously.

Channel

This selects which channel is to be used as the trigger input. 

Note: On oscilloscopes from the ADC-200 series, and the 3204/5/6 oscilloscopes, the
external trigger is the same connector as the signal generator, so you cannot use both
functions at the same time (unless, of course, you wish to trigger from the signal
generator).

Direction

The trigger direction can be either rising or falling. When rising is selected, the trigger
event occurs when the voltage rises across the trigger threshold.
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Threshold

This shows the voltage (in millivolts, or in the units of the active window) that the trigger
channel must cross in order for a trigger event to occur.

Delay after trigger

This controls the time delay, as a percentage of the scan time, between the trigger event
and the start of collecting data. A negative delay means that the computer will show data
that was recorded before the trigger event. For example, -50% places the trigger event in
the middle of the collected data and -100% means that all data is before the trigger.

Use equivalent time sampling (ETS)

This option enables ETS. Checking this option is the same as selecting ETS from the
Trigger drop-down box in the sampling and trigger toolbar at the bottom of the scope
window. Enabling ETS adds some faster timebases to the timebase list in the
oscilloscope toolbar - usually there are three extra timebases that are two, five and ten
times faster than the fastest standard timebase.

Select one of these timebases if you want higher time resolution and your signal is
periodic and highly repeatable. A signal that varies from one period to the next will give
spurious results with ETS.

Some oscilloscopes do not support ETS, in which case this option is disabled.

Auto trigger after

If auto trigger is disabled, PicoScope will be left waiting indefinitely for the event. This
locks up the computer (except if you are using an oscilloscope from the ADC-200 or
PicoScope 2000 or 3000 series.) If it is enabled, PicoScope triggers after the specified
period of time, even if no trigger event occurs.

Note:- If you turn off auto-trigger when using a product other than an oscilloscope from
the ADC-200 or PicoScope 2000 or 3000 series, PicoScope locks the computer until a
trigger event occurs. If PicoScope does become stuck, click on the Stop button in the 
Sample and trigger toolbar, then press F9 (16-bit applications) or F10 (32-bit applications)
to cancel the trigger.

Save on trigger

When this box is checked, PicoScope saves the data to disk each time a trigger event
occurs. This is useful if you wish to record all occurrences of an event which happens
only occasionally. You can then use the Open Next/Open Previous menu options to look at
each of the saved files.
Note: To prevent accidental filling of your disk with data files, there is a limit of 100
save-on-trigger files per session. To change this limit, see Initialisation settings.

Stop after trigger

When this box is checked, PicoScope stops collecting once it has collected one block of
data after a trigger event.

Beep on trigger

If this box is checked, the computer will make an audible alert on a trigger event.
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5.1.2 Print dialog box

From the File menu, select Print.

This dialog box enables you to print either the active window or all windows. To print the
active window, select the radio button adjacent to Current view only, then click OK. To print
all windows, select the radio button adjacent to All views, then click OK. 

If you are using the X multiplier function to increase the extent of the X axis, select the
radio button adjacent to Multiple pages for zoomed views. This will print a trace with a high
sampling rate - one that extends beyond the limits of an oscilloscope window - in its
entirety, on multiple A4 pages. With the multiplier set to x2, you will find the trace takes
up 2 pages; with the multiplier set to x5, you will find the trace takes up 5 pages, and so
on. To print a magnified section of the trace, leave the radio button unselected.

5.1.3 Notes dialog box

From the Settings menu, select Notes....

This dialog box enables you to add some notes to the active window. The notes will be
displayed at the bottom of the window and will appear on printed reports. Each window
can have its own set of notes. 

You must enable this facility in the Display Preferences dialog box.
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5.1.4 Signal generator

From the Settings menu, select Signal Generator....

This dialog box allows you to adjust the frequency, waveform, and sweep settings of the
signal generator. The settings available vary depending on which oscilloscope you are
using. 

To turn on the signal generator, click the Enabled tick box. 

To operate the signal generator in its simplest mode, type in a frequency in the text box
labelled Frequency:. If the frequency entered is not available, PicoScope will automatically
choose the nearest frequency, either higher or lower. Note: When you use PicoScope in
conjunction with an oscilloscope from the ADC-200 series, the signal generator works up
to 250 kHz; with the 3204/3205/3206 oscilloscopes, the signal generator works up to 1
MHz.

To use sweep mode, click the Active tick box in the Sweep Mode section of the dialog box,
and enter a  frequency in the Stop Frequency (Hz) text box. The value you enter must be
higher than the initial frequency you entered in the Frequency: text box.  

Next, if required, click the Dual Slope and Repeat Signal in combination or singly. In dual
slope mode, when the signal reaches the stop frequency, it starts moving back towards
the start frequency. If dual slope mode is not selected, once the stop frequency is
reached, the signal immediately jumps back to the initial frequency.

Finally, enter your increment size and time in the text boxes labelled Increment and ms

respectively, then click the OK button.

Notes

On oscilloscopes from the ADC-200 and 3204/3205/3206 series, the signal generator
shares a connector with the external trigger input. It is not possible, therefore, to use the
signal generator and the external trigger at the same time (although there is the option of
triggering from the signal generator.) Oscilloscopes from the ADC-200 series provide only
fixed-frequency square wave signals. The PicoScope 3204 provides variable-frequency
square wave signals. The PicoScope 3205 and PicoScope 3206 models provide square,
sine, and triangle wave signals, with optional frequency sweep. 
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5.2 Channel configuration

5.2.1 ADC-11/22

From the Settings menu, select Channels....

This dialog box enables you to select which input channels to display in the active window
and to set the input voltage ranges.

Channel

The ADC-11/22 can collect data from four channels. If you want to collect data from more
than one channel, use Alternate mode.

Range

This is generally set to volts.

If you add custom ranges to scale the input from sensors (for example, pressure or
acceleration), the custom ranges will appear here and you must select them here if you
want to use them.

Multiplier

When a Y axis multiplier is set to Off, the computer displays the full voltage range over
the height of the window. 

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar at the left or right of the window. You can use this scroll bar
to move the trace up or down, to move it away from other traces.

If you change the Y multiplier to x2 or above, the computer displays only half of the
voltage range, but twice as big. The scroll bar now controls which portion of the voltage
range is displayed.
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5.2.2 ADC-100 series

From the Settings menu, select Channels....

This dialog box enables you to select which input channels to display in the active window
and to set the input voltage ranges.

Channels

With an oscilloscope from the ADC-100 series, you can collect data from a single
channel, or from a pair of channels. If you want to collect data from more than one
channel, there are two modes available: Chop mode and Alternate mode.

Voltage range

oscilloscopes from the ADC-100 series have a number of input voltage ranges. You can
either specify an input voltage range, or select Auto, which means the ADC will
automatically adjust the voltage range to suit the input signal. 

Note: Auto mode does not give good results with trigger signals that occur only once, as
PicoScope does not know in advance what range to use.

If you add custom ranges to scale the input from sensors (for example, pressure or
acceleration), the custom ranges will appear here and you should select them here if you
want to use them.

Y axis multiplier

When a Y multiplier is set at Off, the computer displays the full voltage range over the
height of the window. 

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar at the left or right of the window. You can use this scroll bar
to move the trace up or down, to move it away from other traces.

If you change the Y multiplier to x2 or above, the computer displays only half of the
voltage range, but twice as big. The scroll bar now controls which portion of the voltage
range is displayed.
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5.2.3 ADC-200 series

From the Settings menu, select Channels....

This dialog box enables you to select which input channels to display in the active window
and to set the input voltage ranges.

Channels

With an oscilloscope from the ADC-200 series, you can collect data from a single
channel, or from a pair of channels. If you want to collect data from more than one
channel, there are two modes available to you: Chop mode and Alternate mode.

Voltage range

Oscilloscopes from the ADC-100 series have a number of input voltage ranges. You can
either specify an input voltage range, or select Auto, which means the oscilloscope will
automatically adjust the voltage range to suit the input signal. 

Note: Auto mode does not give good results with trigger signals that occur only once, as
PicoScope does not know in advance what range to use.

If you add custom ranges to scale the input from sensors (for example, pressure or
acceleration), the custom ranges will appear here.  You must select them to activate
them.

Y axis multiplier

When a Y multiplier is set at Off, the computer displays the full voltage range over the
height of the window. 

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar at the left or right of the window. You can use this scroll bar
to move the trace up or down, to move it away from other traces.

If you change the Y multiplier to x2 or above, the computer displays only half of the
voltage range, but scaled to twice normal size. The scroll bar now controls which portion
of the voltage range is displayed.

Coupling

You can switch oscilloscopes from the ADC-200 series between AC and DC using this
drop-down menu, or you can use the controls on the instrument toolbar. 
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5.2.4 PicoScope 2000/3000 Series

From the Settings menu, select Channels....

These dialog boxes enable you to select which input channels to display in the active
window and to set the input voltage ranges.

Channels

You can collect data from a single channel, or from two or more channels. If you want to
collect data from more than one channel, there are two modes available to you: Chop
mode and Alternate mode.

Voltage range

The oscilloscopes have a number of input voltage ranges. You can either specify an input
voltage range, or select Auto, which means the oscilloscope will automatically adjust the
voltage range to suit the input signal. 

Note: Auto mode does not give good results with trigger signals that occur only once, as
PicoScope does not know in advance what range to use.

If you add custom ranges to scale the input from sensors (for example, pressure or
acceleration), the custom ranges will appear here.  You must select them to activate
them.

Y axis multiplier

When a Y multiplier is set at Off, the computer displays the full voltage range over the
height of the window. 

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar at the left or right of the window. You can use this scroll bar
to move the trace up or down, to move it away from other traces.

If you change the Y multiplier to x2 or above, the computer displays only half of the
voltage range scaled to twice normal size. The scroll bar now controls which portion of
the voltage range is displayed.

Coupling

You can switch PicoScope 2000 and 3000 series oscilloscopes between AC and DC
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using this drop-down menu, or you can use the controls on the instrument toolbar. 

5.2.5 DrDAQ

From the Settings menu, select Channels....

This dialog box enables you to select which input channels to display in the active window
and to set the input voltage ranges.

Channel

DrDAQ can collect data from four channels in PicoScope. If you collect data from more
than one channel, you can optionally use Alternate mode.

Range

By default, this is set to Volts. If you add custom ranges to scale the input from sensors
(for example, pressure or acceleration), the custom ranges will appear here and you must
select them to use them.

Multiplier

When the Y multiplier is set at Off, the computer displays the full voltage range within the
boundaries of the instrument window.

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar. You can use this scroll bar to move the trace up or down,
away from other traces.

If you change the Y multiplier to x2, the computer displays only half of the voltage range,
but at double magnification. The scroll bar now controls which portion of the voltage
range is displayed.
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5.3 Measurement setup

5.3.1 Introduction

The measurement facilities in PicoScope enable useful oscilloscope and spectrum
analyser readings to be taken automatically, and in real time. This reduces the amount of
manual data processing you need to do once your data has been collected. 

5.3.2 Oscilloscope

To find out what oscilloscope measurement facilities are available, see the list below. For
information on how to add a measurement facility - to be included at the foot of an
oscilloscope trace - go to the Measurement details dialog box.

Frequency. The reciprocal of the duration of one cycle.
High pulse width. The duration over which the signal is above a certain set threshold.
Low pulse width. The duration over which the signal is below a certain set threshold.
Duty cycle. The ratio of the time above the threshold to the duration of one complete
cycle, expressed as a percentage.
Cycle time. The time taken for one complete cycle.
DC voltage. The average voltage during one complete cycle.
AC voltage. This the RMS sum of the reading minus the DC voltage for one complete
cycle.
Peak to peak. The difference between the maximum peak and minimum peak.
Crest factor. The ratio of the peak voltage to the RMS voltage.
Minimum. The minimum value recorded.
Maximum. The maximum voltage recorded.
Rise time. The time taken to go from 20% of peak amplitude to 80% of peak amplitude.
Fall time. The time taken to go from 80% of peak amplitude to 20% of peak amplitude. 
Rising rate. The slew rate calculated using the two samples either side of the threshold,
on a rising edge, expressed as:

Rising rate = (Vn - Vn-1) / (Tn - Tn-1)

Falling rate. The slew rate for the two samples either side of the threshold, on a falling
edge, expressed as: 

Falling rate = (Vn - Vn-1) / (Tn - Tn-1)

Voltage at X cursor. The computer identifies the samples immediately before and after
the vertical cursor labelled 'x', then interpolates the voltage at the cursor point.
Voltage at O cursor. The computer identifies the samples immediately before and after
the vertical cursor labelled 'o', then interpolates the voltage at the cursor point.
Time at X cursor. The time in the current cycle at which the trace crosses the vertical
cursor labelled 'x'.
Time at O cursor. The time in the current cycle at which the trace crosses the vertical
cursor labelled 'o'.
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5.3.3 Spectrum analyser

This section describes the measurements available on spectrum analyser windows and
the concepts involved in spectrum measurements.

Most measurements are based on a data source. The source for measurements on the
spectrum analyser window can be defined as any one of the following:

At peak

Position of the highest amplitude signal

At X

Position of the X cursor

At O

Position of the O cursor

O to X

Position of both cursors (intermodulation distortion only)

For each measurement, the data source can be specified.

Ratio measurements can be displayed as percent or dB: this can be specified for each
measurement.

The default values for the data source and percent/dB can be specified in the Measurement

options dialog box.

For harmonic analysis, the harmonics are integer multiples of the data source. The band
number of the nth harmonic may be adjusted by ±n/2 bands to take account of rounding
of the data source to the nearest band. The number of harmonics to include can be
specified in the Measurement options dialog box. If the specified number of harmonics is not
available within the selected frequency range, any measurements that require the
harmonics will be left blank.

Ideally if an FFT were performed on a perfectly pure sine wave, the frequency display
would show only an infinitely thin spike at the fundamental frequency of that sine wave. In
reality the frequency information tends to get spread out by the finite number of FFT
points and end effects which leads to a broadening of the spike. The measurement
calculations will use expected values for the spread. These will be a function of the
number of points and the window type. 

Another effect of the FFT process is to lump all the components which are varying more
slowly than the entire sampling period into a band labelled as DC. This can lead to a false
impression of the actual DC value. The measurement calculations deal with this by
ignoring the first spread bands.

Frequency

This displays the peak frequency of the data source.

Amplitude

This displays the peak amplitude of the data source.
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Total power

This displays the total power of the entire spectrum.

Calculated by taking the root of the sum of each RMS-value-squared.

Total power = sqrt(sum(value²))

THD

Total Harmonic Distortion. This is the ratio of the harmonic power to the power at the
datum. In the following equation, V1 is the RMS value at the datum frequency and V2..V5
are RMS values at the harmonics:

THD + Noise

Total Harmonic Distortion + Noise. This is the ratio of the harmonic power plus noise to
the fundamental power. THD+N values will almost always be greater than the THD values
for the same signal. THD + Noise can be expressed as:

SFDR

Spurious Free Dynamic Range. This is the ratio of the amplitude of the datum point
(normally the Peak Frequency component) and the frequency component with the second
largest amplitude (call it "SFDR frequency"). The component at the "SFDR frequency", is
not necessarily a harmonic of the fundamental frequency component. For example it
might be a strong, independent noise signal.

SINAD

Signal to Noise and Distortion Ratio. This is the ratio, in decibels, of the
signal-plus-noise-plus-distortion to noise-plus-distortion.

Note: Hanning or Blackman windows are recommended because of their low noise.

SNR

Signal to Noise Ratio. This is the ratio, in decibels, of the mean signal power to the mean
noise power.

Note:- Hanning or Blackman windows are recommended because of their low noise.



PicoScope User Guide39

Copyright 1995-2007 Pico Technology Limited. All rights reserved.PSW044 v1.8

IMD

Intermodulation Distortion. This is a measure of the distortion caused by the nonlinear
mixing of two tones.

When multiple signals are injected into a device, modulation or nonlinear mixing of these
two signals can occur. For input signals at frequencies f1 and f2, the two second-order
distortion signals will be found at frequencies:

f3 = (f1 + f2) 
and 

f4 = (f1 - f2). 

IMD is expressed as the dB ratio of the RMS sum of the distortion terms to the RMS sum
of the two input tones. IMD can be measured for distortion terms of any order, but the
second-order terms are most commonly used.

In the second-order case, the intermodulation distortion is given by:

where 
F3 and F4 are the amplitudes of the two second-order distortion terms (at frequencies
f3 and f4 defined above) 

and 
F1 and F2 are the amplitudes of the input tones (at frequencies f1 and f2, as marked by
the frequency rulers in the spectrum window).

For reference, the third-order terms are at frequencies (2F1 + F2), (2F1 - F2), (F1 + 2F2)
and (F1 - 2F2).

Note: Hanning or Blackman windows are recommended because of their low noise. An
FFT size of 4096 or greater is recommended in order to provide adequate spectral
resolution for the IMD measurements.

Second, Third, Fourth, Fifth, Sixth

The amplitude at the second, third, fourth, fifth or sixth harmonic.

Gain

The ratio of the power in channel A to the power in channel B at the reference point. This
is used to check the gain of an amplifier.

Scan time

The time it took to record the data currently displayed.
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5.3.4 Measurement list dialog box

From the Settings menu, select Measurements.

The Measurement list dialog box displays a list of measurements to be displayed on the
oscilloscope window. 

Add

To add a new measurement, click on the Add button. The computer will display the
Measurement details dialog box.

Edit

To edit an existing measurement, either double-click on one of the measurements in the
measurement list, or select a measurement, then click on the Edit button. In either case,
the computer will display the Measurement details dialog box.

Delete

To delete an existing measurement, select the measurement, then click on the Delete

button. The measurement will be removed from the list.

Options

This button opens up the Measurement options dialog box.
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5.3.5 Measurement options dialog box

From the Measurement list dialog box, select Options. 

This dialog box allows you to specify a number of options that apply to all measurements.

Statistics

These check boxes select the statistical values to be displayed at the base of the
oscilloscope trace. The following check boxes are available:

  Current value

The most recent measurement
  Average

Average of all measurements since reset
   Standard deviation

The standard deviation since reset
  Maximum

The maximum since reset
  Minimum

The minimum since reset
  Pass/fail

The text 'Fail' is displayed if the measurement is out of alarm limits.

No of readings

This specifies the number of readings to be used to update the statistics. The displayed
values are updated continuously until the specified number of readings is reached. After
this, the statistics freeze and an asterisk is displayed next to the average. The statistics
are reset if any parameter changes or if data collection is restarted by clicking on the start
button.

Default source

There are two default source fields- one for oscilloscope measurements and one for
spectrum analyser measurements. When a new measurement is added, the appropriate
value is used as the default data source. See the information on the Measurement details

dialog box for a list of the possible options. 
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Threshold

The threshold used for frequency and pulse width measurement is normally calculated
automatically. This option can be used to specify a horizontal ruler to use as the
threshold. The options are:

  Automatic

Calculate the threshold automatically
  X ruler

Use the X ruler as the threshold
  O ruler

Use the O ruler as the threshold

Aggregate cycles

When this box is checked, the computer aggregates the values for all cycles in the trace.
This gives a better current value but may give a misleadingly small variation for minimum,
maximum and standard deviation. If the box is unchecked, the statistics are updated for
each individual cycle, rather than for the aggregate of all cycles in a trace. The default is
to use the aggregate.

Max harmonic for THD

Some spectrum measurements, for example THD, calculate values using a fundamental
frequency and its harmonics. This field selects the highest harmonic to be used for these
calculations. For example, if Max Harmonics is set to Third, only the second and third
harmonics will be considered for THD calculations.

Use dB

This is used as the default value for the Use dB field for spectrum measurements.

Error action

This specifies what action is to be taken if a measurement is outside the alarm limits. The
options are as follows:

  None

No action taken
  Beep

Audible alarm signal
  Stop

Measuring stopped
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5.3.6 Measurement details dialog box

From the Measurement list dialog box, select a measurement, then click on Edit.

This dialog box allows you to specify the details for one measurement.

Measurement

This selects the type of measurement required. Full lists of measurement types are
provided for the Oscilloscope and Spectrum analyser windows.

Source

This specifies the part of the trace to use for the measurement. Rulers, if specified, must
be vertical. The options for an oscilloscope measurement are:

  Cycle at O ruler

The cycle in which the O ruler falls
  Cycle at X ruler

The cycle in which the X ruler falls
  Between cursors

The area between the cursors
  Whole trace

The entire trace

The options for a spectrum measurement are:

  At Peak

The peak frequency (the strongest signal)
  At O

The frequency of the O ruler
  At X 

The frequency of the X ruler

Channel

This specifies the channel to use for the measurement. For most parameters, a single
channel is required. For phase angle, two channels must be specified.

Use dB

This is used only for spectrum measurements. If checked, the result is displayed in dB,
otherwise it is displayed in percent.

Alarm Limits

These are the minimum and maximum alarm limits. If the measured value goes outside
this range, the alarm action specified in the Measurement options dialog box will be taken.
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5.4 Custom range settings

5.4.1 Custom range list

From the Settings menu, select Custom Ranges.

Use this dialog box to maintain a list of custom ranges. These are useful for displaying
the results from nonstandard probes, transducers and sensors. The custom ranges
appear after the voltage ranges in the ADC Channels dialog box.

The text box displays the list of custom ranges.

Add

This button opens a dialog box enabling you to add a new custom range.

Edit

To edit an existing range, highlight the range in the list and then click on this button.

Delete

To remove an existing range, highlight the range in the list, then click on this button.

Note: To use these custom ranges, they should be selected from Channels dialog box or
the control bars.
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5.4.2 Edit custom range

From the Custom range list dialog box, select a custom range, then click on Edit.

You use this dialog box to add or edit a new custom range. Note: When you use DrDAQ,
there is a different dialog box.

For your information, the signal conditioner information is derived from the Signal

conditioner files. You can create a user PSC file for sensors that you wish to use regularly.
See the signal conditioner help for more information about these files or any other aspect
of signal conditioners. 

Using a signal conditioner:

1  Select the appropriate conditioner: the Sensor box will then show a list of sensors for
the selected conditioner

2  Select a sensor, the computer fills in the minimum and maximum value and the units
for this sensor

3  You can, if required, alter the minimum and maximum values if you are using only part
of the range. For example, Pt100 goes from -200°C to 370°C). But you may wish to
display 0 to 100°C. You can even create two Pt100 custom ranges- one for 0 to 100
and another for 0 to 200, if required

Using your own sensor:

1  Leave the conditioner and sensor set to None

2  Type in pairs of raw and scaled values in the edit box. For example, if you are using a
pressure sensor that produces 0 mV at 0 bar and 2000 mV at 100 bar, type in:
0 0
2000 100

3  The min and max values will be updated as you enter the values. For a sensor with a
linear output, you should enter two pairs of values - the minimum and the maximum. If
the sensor has a non-linear response, you should enter more pairs of values

4  Type in the units (bars in this case)
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5.4.3 Edit DrDAQ custom range

From the Custom range list dialog box, select a custom range, then click on Edit. 

You use this dialog box to add or edit a custom range for a DrDAQ sensor.

Note: You can also create custom scalings for DrDAQ by creating a DDS file: see the
DrDAQ help file for more information.

1 Select the input channel that you wish to scale
2 Type in pairs of raw and scaled values in the edit box. For example, if you are using a

pressure sensor that produces 0 mV at 0 bar and 2000 mV at 100 bar, type in:
0 0
2000 100

3 For a sensor with a linear output, you should enter two pairs of values- the minimum
and the maximum. If the sensor has a non-linear response, you should enter more
pairs of values

4 Type in the units (pascal in this case)
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5.5 ADC setup

5.5.1 ADC Selection

From the File menu, select Setup, then Converter.

You use this dialog box to select the type of oscilloscope and the port you have
connected it to. If you are using an oscilloscope from the PicoScope 2000 or 3000 series,
you do not need to specify the port.

ADC Type

A drop-down list of all the compatible oscilloscopes. PicoScope supports one oscilloscope
at a time.

Printer port

(This option is enabled only for parallel-port oscilloscopes).

Select the physical port to which the oscilloscope will be connected from the drop down
list (default LPT1 - parallel port):

  One of the three standard printer ports: LPT1...LPT3
  One of the four Pico USB parallel ports (USB-PP1...USB-PP4)

Note: On Windows NT/2000/XP computers, the LPT number may not be as expected. If
LPT1 does not work, try LPT2 or 3.
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5.5.2 Display Preferences

From the File menu, select Setup, then Display.

This dialog box contains a number of options which affect how all windows are displayed.

Maximum displays per second

This controls the display update rate. The higher the number, the more frequently
PicoScope collects data and updates the screen. At high update rates, the computer may
be so busy that it is difficult to use other applications or even to control PicoScope.

Display notes in views

If you check this option, the computer displays any notes that you have entered for a
window at the bottom of the window. This may be inconvenient in a small window. Notes
always appear on print-outs.

Display datestamp in views

If you check this option, the computer displays the time and date that data was collected
at the bottom of the window. This may be inconvenient in a small window. The timestamp
always appears on print-outs.

Display view bar at top of window

You can select whether or not to have the instrument toolbar displayed at the top of the
screen. It is useful to turn off the instrument toolbar if you wish to use PicoScope within a
small window, or you wish to prevent operators from changing the settings.

Display sampling bar at bottom of window

You can select whether or not to have the sample bar displayed at the bottom of the
screen. It is useful to turn off the sample bar if you wish to use PicoScope within a small
window, or you wish to prevent operators from changing the settings.
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5.5.3 Colour settings

From the File  menu, select Setup, then Colours.

This dialog box enables you to select the colours for the various components in an
instrument window. This facility may be especially useful on laptop computers if the
default colours do not display very clearly.

To change the colour of a component, click a block of colour adjacent to a component
name. A dialog box will open in which you can select a new colour.

Note: On oscilloscope windows, trace colours are used for both the Y axis scale and the
trace.
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5.6 Oscilloscope configuration

5.6.1 Scope Options

From the Settings menu, select Options....

This dialog box is used to set a number of optional features for the active oscilloscope
window. If the oscilloscope is running whilst this dialog box is active, you can use the 
Preview button to apply the effects directly to the trace. You can either save these
changes by clicking on Ok, or you can revert to the original settings by clicking on Cancel.

Note: These functions are not available on the Oscilloscope toolbar.

Title

This is used to set the title for the active window. It appears on the title bar of the window
and on printed reports.

Display Mode

You can display data in several formats, some based on single cycles of data and others
on multiple cycles. 

The following two single cycle display modes are available:

  Current (Unfiltered)

This is the default display mode. All the points of the current cycle are displayed,
without any filtering being done

  Current, (Filtered)

This involves use of a simple filter to help remove high frequency noise from the active
trace

In multi-cycle display modes, previous cycles affect how the active cycle is displayed. For
example, a particular section of a trace may be displayed in a different colour depending
on how often cycles pass over each other. You can reset the results so far by clicking on
the Stop button, then the Start button. Below is a list of all the multi-cycle modes:
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  Average

The average of all cycles since you started. This is useful for removing random noise
from the active trace

  Min, max & average

A shaded area showing the minimum and maximum of all cycles since you started with
a trace showing the average. As with average, this removes random noise from
repetitive signals. In addition, this also gives an indication of the level of noise of a
signal.

  Min, max & current

A shaded area showing the minimum and maximum of all cycles since you started with
a trace showing the current data. This mode is ideal for measuring the time jitter of
signals such as clock waveforms.

  Digital colour

This mode, a type of persistence mode, is ideal for spotting intermittent glitches in
digital signals. The area of the trace that has the highest population density is red,
whereas the area with the lowest population density is blue. Digital colour mode does
not decay over time. 

  Analog intensity

This mode emulates the phosphor display of a conventional analog oscilloscope and is
useful for displaying complex analog signals such as video waveforms and analog
modulation signals. The area of the trace that has the highest population density is the
strongest colour. The area with the lowest population density and/or a high slew rate
(low rise time/fall time) is the lightest colour.

Persistence

This option is available in both analog intensity and digital colour modes. The word
'persistence' in this context refers to the length of time a trace remains on the screen. The
following options are available in the drop-down list:

  No Persistence

Only the current trace is displayed. This may be useful in analog intensity mode if you
have a very large number of samples

  500 ms

  1 second

  5 seconds

  15 seconds

  30 seconds

  60 seconds

  Infinite persistence

Saturation (%)

This option is available in both analog intensity and digital colour modes. 

The saturation control bar is used to adjust the colour-coding applied to the population.
This can reveal more detail contained in areas where the population density is lower.

A 0% saturation level will show only the most densely populated areas as the hottest or
boldest colours, while the 50% saturation level shows the upper half of the population
range as the hottest or boldest colour.

Advanced >>

The Advanced >> button opens the Scope Advanced Options dialog box.
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5.6.2 Scope Advanced Options

From the Settings menu, select Options..., then click on the Advanced >>> button.

Maximum samples per scope trace

The computer can collect many more samples per scan than can be displayed on the
screen. You can then zoom in on a small part of the trace to examine it in more detail.
The default number of samples is 2500. 

This option enables you to set the maximum number of samples. If you select a larger
number, you will see more when you zoom in. If you select a smaller number, the display
will be updated more frequently. The computer may also be able to use the average of a
number of readings for each sample, which will result in a smoother trace.

If you add an oversampling parameter to the INI file, you should make sure that
Maximum samples per scope trace multiplied by the oversampling factor does not
exceed the size of the converter's memory.  If the number exceeds the memory size,
PicoScope will not be able to use the oversampling factor that you requested.

ETS oversample

This specifies the amount of oversampling to use when PicoScope is running in ETS
(equivalent time sampling) mode. If, for example, PicoScope needs to display 10 cycles
interleaved and the oversample is set to 3, PicoScope will collect 30 cycles and then
display the best 10. A higher oversample gives more uniformly spaced samples, but
takes longer to collect.

ETS update speed

This has two options - fast and slow. For slow, each display is made up of fresh data,
whereas in fast mode only (1/oversample) cycles will be new data. For example, if
oversample is 3, the display will be updated three times as fast in fast mode, but only 1/3
of the points will be updated each time.
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Slow sampling

When the time per scan is more than one second, the computer can work in one of three
ways:

  Standard

The oscilloscope collects data and displays it while scanning. After one complete scan,
the display resets and a new scan is started. Because sampling is controlled by the
computer, gaps may appear in the data whilst the display is being updated. The
maximum sample rate in this mode is one sample per millisecond.

  Chart recorder

The oscilloscope collects data and displays it during the scan. After a complete scan,
the display scrolls to show the most recent data. Because sampling is controlled by the
computer, gaps may appear in the data whilst the display is being updated. The
maximum sample rate in this mode is one sample per millisecond. Note: Chart
recorder mode is only compatible with trigger modes.

  Block mode

The oscilloscope collects data and displays it after the scan. Gaps in the data due to
display updates are therefore eliminated. The sample rate can be greater than one per
millisecond; therefore the number of samples per scan may be increased.

Display a grid

The computer normally displays a 10x10 grid on the oscilloscope window. You can turn
this off if it obscures important information.

Display axis scaling

The computer normally displays the voltage along the Y axis and the time along the X
axis. You can turn this off if you would like to have all of the window used for the trace
itself.

Note: If you make the window very small by resizing it, the scale will no longer be
displayed.

Scope timebase is time per division

On a conventional analog oscilloscope, the screen has a 10x8 grid and the timebase
knob sets the time interval for one division of the grid. If you are familiar with this way of
working, you can check this box to make PicoScope work exactly the same.

Unlike a normal oscilloscope, PicoScope displays actual times across the screen and has
rulers to measure time intervals so it is not necessary to count grid lines. If you do not
normally use an oscilloscope, you may find it easier to leave this box unchecked so that
PicoScope lets you specify the scope timebase in terms of the time per complete scan.

Default button
This button returns all the settings in the Scope Options and Scope Advanced Options dialog
box to their defaults.
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5.6.3 Scope Timebase

From the Settings menu, select Timebase...

This dialog box is used to set the timebase (the X axis) for the active oscilloscope window
. These functions are duplicated on the oscilloscope toolbar.

Time/div or Time/sweep

If you checked Scope timebase is time per division in the Scope Advanced Options dialog box,
the timebase field is labelled Time/div and controls the time interval between the grid lines
of the oscilloscope - equivalent to the 'time per division' used on conventional
oscilloscopes. The screen is ten divisions wide, so the total time is 10x the time per
division.

If you turned off Scope timebase is time per division, the timebase field is labelled Time/sweep

and controls the total time interval for a scan. 

X multiplier

If you set the X multiplier to 1, the computer displays all of the data that it has collected
across the full width of the window. If you change the X multiplier to x2, the computer
displays only half of the data, but twice as big. It also displays a scroll bar across the
bottom of the window, which you can use to control which portion of the data is displayed.
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5.7 Spectrum analyser configuration

5.7.1 Spectrum Options

From the Settings menu, select Options....

This dialog box controls a number of optional features of the active spectrum analyser
window.

Note: These functions are not available on the spectrum analyser toolbar.

X scale

The X axis represents frequency. You can display the frequency either in linear or in
logarithmic form.

Y scale

On the spectrum analyser display, the Y axis represents the power at a specified
frequency. The power can be expressed either as volts (RMS), or as dB.

Window

PicoScope performs an analysis on a short block of samples. The 'cutting' of this block
from the data stream can introduce distortion which produces side-lobes on spectrum
peaks. This effect can be reduced by multiplying the block of data by a set of factors
which 'rounds off' the ends of the data. This technique is known as windowing.

PicoScope supports several different windowing methods. No windowing algorithm is
guaranteed to eliminate all end-effects but switching between two methods can give a
clue to whether a particular peak is a side-lobe or a genuine peak. A rectangular window
is generally best for estimating an exact frequency, whereas a Blackman window is often
best for minimising side-lobes.

No of spectrum bands

A fast fourier transform divides up a signal into a number of frequency bands. More
bands gives higher resolution, but it is necessary to collect and process more data. This
reduces the display update rate, and reduces effectiveness when dealing with
impulse-type signals. You can select between 128 and 4096 frequency bands, in powers
of two.
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Display mode

You can display the following traces:

  Current

The spectrum for the current cycle;
  Average

A moving average of successive cycles (useful for removing random noise); and
  Peak

Displays the maximum of all cycles since the start (reset by stop/restart). Useful for
plots of swept-sine.

Display a grid

The computer normally shows a grid corresponding to the scale points of the power and
frequency axes. You can turn this grid off if it obscures important features of the data.

5.7.2 Spectrum Timebase

From the Settings menu, select Timebase....

This dialog box is used to set the maximum frequency for the spectrum analyser. This
function is duplicated on the spectrum analyser toolbar.

Max frequency

The maximum frequency controls the sampling rate of the data collected for spectrum
analysis. This, in turn, determines the highest frequency that the spectrum analyser can
display.

Note: The lower the maximum frequency, the longer it takes to collect enough data to
display a spectrum. At very low maximum frequencies, this may affect the response time
of your computer to keyboard input.

X multiplier

When the X multiplier is 1, the computer displays the entire frequency range across the
full width of the window. If you change the X multiplier to x2, the computer displays only
half of the frequency range, but twice as big. It also displays a scroll bar across the
bottom of the window which you can use to control the frequency range that is displayed.
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5.8 XY scope configuration

5.8.1 XY Options

From the Settings menu, select Options....

This dialog box sets a number of optional features for the active XY oscilloscope window
that are not controlled by the XY oscilloscope toolbar.

Title

This sets the title that will appear on the active window's title bar and on printed reports.

Accumulate successive cycles

If you set PicoScope to trigger in Repeat or Auto modes, it is easy to miss unusual events.
If you check this option, PicoScope draws each new trace without erasing the previous
trace. This helps you to see variations between traces, or the occasional unusual trace.

Display grid

The computer normally displays a 10x10 grid on the oscilloscope window. You can turn
this off if it obscures important information.

Display axis scaling

The computer normally displays the voltage along the X and Y axes. You can turn this off
if you would like to use all of the window for the trace itself.

The voltage scales are not displayed if the window is too small.
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5.8.2 XY Timebase

From the Settings menu, select Timebase....

This dialog box controls the timebase for the active XY scope window.  

Time per scan

The time per scan field sets the time interval between refreshes of the XY display.  You
should select a timebase slightly longer than the cycle time of your signal.  This function
is duplicated on the oscilloscope toolbar.

5.9 Meter configuration

5.9.1 Meter Options

From the Settings menu, select Options....

This dialog box controls the options for the active meter window.

Title

This field is used to specify the title for the meter window.

Single parameter

A meter window can work in two ways: single-parameter and multi-parameter.

In the simplest mode, the meter window displays a single parameter measured on one
channel. When you select Meter Parameter, the computer goes straight to the Meter

Parameter dialog box for the single parameter. 

In the more advanced mode, you can display a number of parameters, from more than
one channel, in the same window. The computer displays the parameter name, value and
units for each parameter, one parameter per line. When you select Meter Parameter, the
computer first displays the Meter Parameter List dialog box for the window. When you pick
New or Edit, the computer shows a dialog box in which you can enter details for the
selected parameter.
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5.9.2 Meter Parameter List

From the Settings menu, select Parameters....

Turn off the 'single parameter' option on the Meter Options dialog box.

This dialog box is used to add new parameters and to edit or delete existing parameters.

At the left of the window is a list of the currently specified parameters. At the right of the
window are a number of buttons which enable you to add edit or delete parameters.

New

To create a new parameter, click on the New button. The computer will display the Meter

Parameter dialog box containing the default settings.

Edit

To edit an existing parameter, move the highlight to the parameter entry that you wish to
change and click on the Edit button. The computer will display the Meter Parameter dialog
box containing the default settings.

Delete

To remove an existing parameter from the list, move the highlight to the parameter entry
that you wish to change and click on the Delete button.
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5.9.3 Meter Parameter

From the Settings menu, select Parameters..., then click on the New button.

This option is used to alter the settings for a meter parameter. 

Title

This specifies the name that will appear next to the reading for a parameter (This option
does not appear if 'Single Parameter' has been selected from the Meter Options dialog box.

Channel

This specifies which channel to measure data from.

Function

This specifies which function to use. The options are:

  DC volts

The DC component or average input voltage
  AC volts

The RMS AC voltage (note: this excludes any DC component)
  dB

AC volts converted to dB
  Frequency

Frequency of the AC component, in Hz

Range

This specifies the input voltage range to use.
If you have defined any custom ranges (for example, for a pressure sensor), these
ranges will also appear in the option list.

Display a bar-graph

When this option is checked, the computer displays a bar graph showing the current
reading for this meter parameter.
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5.10 Composite setup

5.10.1 Composite Options

From the Settings menu, select Options...

This dialog box is used to specify the options for the active composite window.

Layout

The instrument windows displayed within the composite window appear in a number of
layouts:

  Overlay

Useful if you wish to compare 'before and after' versions of two traces taken with the
same measurement and scaling parameters

  Side by side

Compare two traces with the same amplitude
  One on top of another

Useful to compare the X (time or frequency) axis for several signals (maximum four
windows)

  Two by two

Display up to four windows in a square
  Automatic

Select whichever format is appropriate, based on what the windows have in common

X Scrolling; Y Scrolling

The windows within the composite can be scrolled using the scroll bars of the original
windows, or using a scroll bar for the composite window. The latter is particularly useful
when using the Overlay or One on top of another formats.

For each axis, it is possible to select whether to use the scroll bar of the original or the
composite window, or to automatically select.
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5.10.2 Composite windows, or views

From the Settings menu, select Views...

This dialog box is used to select the instrument windows, or views, that will be included in
a composite window.

The list box shows the titles of all windows - the ones that are currently included in the
composite window are highlighted. To add or remove a view, or window, from the
composite, use the mouse to left-click on the window title.
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6 Common tasks
6.1 Adding a custom range

Custom Ranges are used to display a trace in units of your choice. For example, to
display the output of a pressure sensor in pascal.

Non-linear sensors, can also be mapped to new units of measure. PicoScope reads in a 
table of values supplied by the user and interpolates data automatically.

To add a Custom Range:

1  Choose the menu option Settings | Custom Ranges

2  Fill in the scaling look up table and other details in the Edit custom range dialog box
3  Select the custom range from the control bar shown below

6.2 Adding a ruler

To add a vertical ruler:

1  Move the mouse to the approximate position for top of the ruler.
2  Press and hold down the left mouse button while dragging the mouse downwards.
3  PicoScope draws a vertical ruler.
4  Move the mouse left or right to set the required position.
5  Release the left mouse button.
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To add a horizontal ruler:

1  Move the mouse to the approximate position for the left-hand end of the ruler.
2  Press and hold down the left mouse button while dragging the mouse to the right.
3  PicoScope draws a horizontal ruler.
4  Move the mouse up or down to set the required position.
5  Release the left mouse button.

If there are two Y axes, pressing the left mouse button associates a horizontal ruler with
the left axis, and pressing the right mouse button associates a horizontal ruler with the
right Y axis. A small coloured box appears at one end of the ruler to show the axis with
which it is associated. You cannot associate a ruler with the third or fourth channel of a
four-channel oscilloscope.

You can add up to two cursors: if you add more cursors, each new cursor will replace the
oldest one. 

PicoScope will display the current positions of the cursors (labelled "x" and "o").  If the
two cursors are on the same axis, PicoScope will also display the difference ("xo")
between the positions of the two cursors.

6.3 Repositioning a ruler

Once a ruler is positioned, you can move it using the arrow keys. To re-select a ruler so
that you can move it, left-click on it.

6.4 Removing a ruler

1.  Left-click on the ruler you wish to remove
2.  Press the Delete key

6.5 Adding a test menu

If you have a number of standard tests that you carry out regularly, you can add a menu
to select the settings for these tests by name. You can also use this facility to add a menu
of example files that show what particular signals look like.

To add a test menu, it is necessary to create a test menu file. The facility to create this
file is not built into PicoScope; instead, you need to use a text editor like Notepad, or a
word processor.

See Test menus for more details.
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6.6 Changing axis scaling

If you connect a sensor that measures in units other than volts (for example, a pressure
or acceleration sensor), this is how to make PicoScope display the trace scaled in the
appropriate units:

1  Select Settings from the main menu
2  Select Ranges from the settings menu
3  Click on the Add button on the Custom range list dialog box
4  Either select the Pico signal conditioner and sensor, or type in the millivolt and scaled

values (see Edit custom range for more details)

The new custom range will appear after the voltage ranges in instrument toolbars and
dialog boxes.

6.7 Changing the footer on printed graphs

The standard footer for PicoScope contains the program name and contact details for
Pico. You can replace the standard footer with one of your own by editing the Initialisation
settings:

1  Use a text editor like notepad.exe.
2  Open win.ini from the windows directory on the C: drive.
3  Find the section headed [PicoScope for Windows].
4  Add a line Footnote=<the footnote text that you want>.
5  Save win.ini.
6  Restart PicoScope.

6.8 Changing settings

1  Use the mouse to click on the window that you want to change
2  Select Settings from the main menu
3  Select the sub-menu item containing the features that you want to change

See also the information on the Settings menu .

You can also change the most important settings for the active window using the
instrument toolbar displayed at the top of the main window.
 

6.9 Configuring your oscilloscope

1  Select the File | Setup | Converter dialog box from the main menu
2  Use the ADC Type drop down menu to set the type of oscilloscope you are using
3  Set the Port. This should be the port to which the oscilloscope will be connected
4  Click on the OK button
 
Is it set up correctly (ADC-200 and PicoScope 3204/3205/3206)?

1  Connect the Signal Generator / External Trigger output to Channel A
2  Select Settings | Signal Generator

3  Check the 'Enable' box and enter a frequency of 1000 (Hz)
4  Create an oscilloscope window, select 1 ms/div
5  You should see a square wave with one square per division
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Is it set up correctly (other ADCs)?

1  Create a meter window for DC volts and then connect the ADC to a battery. Check that
the voltage is correct

2  Create an oscilloscope window, then connect an oscilloscope probe and touch the
probe with your finger. You should see a small 50 Hz or 100 Hz waveform on the
oscilloscope window

6.10 Converting data files to text

To convert a single file to text:

1  Select File | Open from the main menu
2  Select the file that you wish to convert;
3  Select File | Save from the main menu
4  Change the file type to Text file (*.txt)
5  Enter a filename
6  Click on OK

To convert several files:

1  Close PicoScope for Windows
2  Open a DOS box
3  Go to the directory containing the files that you wish to convert to text
4  Type in the following command: psw -t run*.psd

This command will convert any .psd data file with run as the first three letters into the
corresponding run*.txt.

6.11 Opening an instrument window, or view

Using the main menu:

1  Select View from the main menu.
2  Select the type of view, or window, that you wish to create (oscilloscope, spectrum

analyser or meter, XY oscilloscope, composite)

Using buttons on the instrument toolbar:

  for oscilloscope window

  for spectrum analyser window

  for meter window
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6.12 Displaying measurements

You can display a number of measurements (frequency, rise time, etc) at the bottom of
the oscilloscope or spectrum trace. To do this:

1  Open up an oscilloscope or spectrum analyser window
2  Select Measurements from the Settings menu
3  Click Add

4  On the Measurement details dialog box, specify the details for the measurement
5  Click OK

6  Click Options

7  On the Measurement options dialog box, select the statistics that you require (average,
standard deviation etc)

8  Click OK

9  Click OK

6.13 Printing the contents of a window

1  Use the mouse to click on the window
2  Select File from the main menu
3  Select Print... from the sub-menu
4  To print the active window, click the Current view only check box, then click the OK

button
5  To print all windows, click the All views checkbox
6  Click the OK button

6.14 Exporting to a word processor

This explains how to export the data or measurements for the active window, in text
format, to the clipboard so that you can paste a picture of the window into a word
processor document:

1  Use the mouse to click on the window that you want to copy
2  Select Edit from the main menu
3  Select Copy as Text or Copy measurements

4  Start the word processor program
5  Select Edit

6  Select Paste

You can also export data in graphical format by selecting File | Save As, and save the file in
.WMF (Windows Meta file) format.

6.15 Exporting to a spreadsheet

This explains how to export the data for the active window, in text format, to the clipboard
so that you can perform further analysis on the data:

1  Use the mouse to click on the window that you want to copy
2  Select Edit from the main menu
3  Select Copy as Text

4  Go to the spreadsheet
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5  Select Paste from the Edit menu

If you want the information in the spreadsheet to be updated automatically each time
PicoScope collects new data, select Paste Link or Paste Special rather than Paste as this
creates a DDE link between the applications.

When you transfer data to another application via the clipboard, this writes only the data
that is currently visible- a maximum of about 1000 values. If you wish to transfer all data,
select Save As from the File menu , and save the file in .TXT format.

6.16 Removing an offset

When you are working at low input voltages, there may be a small offset on the ADC
input. You can remove this offset until you exit the program by carrying out an offset null,
as follows:

1  Disconnect or short the input on the appropriate channel
2  Select Settings from the menu bar
3  Select Offset null from the Settings menu
4  Select the channel that you wish to offset null
5  Any offset will be automatically removed from all traces and meter readings

6.17 Selecting x10 probes

You can tell PicoScope that you are using a x10 oscilloscope probe: PicoScope then
displays all voltages ten times higher. The range selections do not change, but traces and
meter readings will be scaled correctly.

1  Select Settings from the main menu
2  Select Probes from the Settings menu
3  The computer shows a menu of x1/x10 for each channel
4  There is a tick next to the currently selected option for each channel
5  Check the option for chA x10 or chB x10.

You can use the same method to use a x20 or x100 oscilloscope probe.

If the fixed attenuation options are not sufficient for your application, you can set up
PicoScope for use with probes of any type by creating a custom range.

Safety note: you should use an isolated oscilloscope probe if you wish to work with, or
near, high voltages.

6.18 Switching to ETS mode

Some products support ETS (Equivalent Time Sampling) mode. This offers a higher
effective sampling rate when used with repetitive signals. Note that ETS should not be
used for one-shot or non-repetitive signals.

1  Open a new oscilloscope window
2  Set the trigger mode to Auto

3  Set the trigger parameters so that the oscilloscope is triggering correctly
4  Set the trigger mode to ETS (note: this will not be available if your product does not

support ETS)
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5  Adjust the timebase to take advantage of the higher effective sample rate
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7 Technical reference
7.1 Introduction

The following sections detail more advanced configuration settings and specifications.

7.2 Dynamic Data Exchange

Dynamic Data Exchange (DDE) is a way of transferring data between Windows programs
so that when data changes in one application, it is automatically updated in another
application. PicoScope for Windows acts as a DDE server by making available a number
of pieces of information (Topics) which other applications (when acting as DDE clients)
can request. This communication is called a DDE link.

The easiest way to set up a link is to use the clipboard. Here is a step by step guide:

1  Open an oscilloscope window and start it running
2  Select Copy as text from the Edit menu
3  Go to the client application (Eg Excel or Quattro Pro)
4  Select Paste link or Paste Special from the Edit menu
5  Click on the place in the spreadsheet where the data is to be placed
6  The oscilloscope data appears in the spreadsheet
7  The data is updated every few seconds

Another alternative is to type into a spreadsheet cell the text necessary to create a link.
To do this, it is necessary to know the Application, Topic and Item which defines the data
that you require. These are as follows:

Application: Psw
Topic: View1 for first view, View2 for second view etc
Item: Text

Here are some examples:

Excel =Psw!View1|Text
Quattro Pro @ddelink([Psw|View1]"Text")

There are a number of restrictions on the DDE functions available:

  Graphical DDE export is not supported
  Composite views do not export text so cannot be used for DDE
  The Excel formula: =PLW|Current!Value supports only one cell, so is of limited use
- use the Excel macro supplied with the software 

7.3 Initialisation settings

When you first run PicoScope, it creates a file called psw.ini in its working directory
and uses it to hold information about the preferences you set when running the program. 

If you wish to use a number of different sets of preferences - for example, to use different
converters - you can do so by creating a number of copies of PicoScope, each saved in a
separate directory. Each copy of PicoScope will use the psw.ini file in its own directory.
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You can change many of these preferences using the Setup option on the File menu, but
there are a number of additional options which you can change only by editing psw.ini
directly, using a text editor such as Notepad. Be sure to close PicoScope before editing
the psw.ini file, otherwise your changes may be overwritten when you exit PicoScope.

PicoScope no longer uses the win.ini file to store its settings.

Preferences in psw.ini

Values shown below are the default settings.

AccumulateLimit=0
When the accumulate option is selected, this defines the number of traces to accumulate
before blanking the screen and starting again.

AllowEarlyTrigger=No
In slow sampling mode, the computer normally waits until it has collected a complete
scan of data before waiting for the next trigger. If AllowEarlyTrigger is set to Yes, it
will restart collecting if a new trigger occurs before the previous scan has completed.

ClipboardMono=No
Some applications cannot print embedded graphs which contain colour. If you wish to use
the clipboard to transfer graphs to an application which does not print them correctly, set 
ClipboardMono to Yes.

Colour0=16777215
The colour of one of the display components, where the digit following 'Colour' is in
the range 0 to 7, for background, grid, text, rulers, and channels A to D, in that order. The
value is R + 256(G + 256 B), where R, G and B are the eight-bit colour coordinates.

Converter=10
The type of converter to use.

DefaultMaxScopeSamples=2500
The value that MaxScopeSamples is set to when Default is selected in the Scope
Advanced Options dialog box.

DisplayNotes=Yes
Whether any notes are to be displayed at the bottom of an instrument window

DisplayTime=Yes
Whether the time and date are to be displayed at the bottom of the instrument window.

DisplayTrigger=Yes
Whether triggering controls are displayed in the sampling bar.

ForceDevice=
Allows the opening of ADC-212/50, ADC-212/100, ADC-200/50 and ADC-200/100 data
files without the unit connected.
Allowable values: 50, 100

Language=044
The language the program should use. It is the international dialling code corresponding
to the country associated with the language.
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MaxOversample=16
The maximum number of readings to take for each sample in oscilloscope mode for the
ADC-200/212/216. For PicoScope 2000 and 3000 series oscilloscopes, see 
MaxScopeOversample. No other products allow oversampling.  This setting interacts
with the Maximum samples per trace setting in the Scope Advanced Options dialog -
which see for details.

MaxScopeOversample=16
The maximum number of readings to take for each sample in oscilloscope mode.  Applies
only to PicoScope 2000 and 3000 series oscilloscopes. (For ADC-200/212/216 products,
see MaxOversample. No other products allow oversampling.)  This setting interacts with
the Maximum samples per trace setting in the Scope Advanced Options dialog - which
see for details.

MaxSOTFiles=100
The maximum number of files to be collected using the save on trigger option.

MaxSpectrumOversample=1
The maximum number of readings to take for each sample in spectrum analyser mode.  It
applies to all products capable of oversampling: ADC-200/212/216 and PicoScope
2000/3000 Series oscilloscopes. While oversampling in spectrum analyser mode is useful
for reducing the effects of noise, it should be used with caution as it also attenuates
signals at the top end of the frequency range.

Patches=f0:2
Whether any patches are to be enabled in the converter driver routine, for example to
allow for unusual printer ports. Do not change this unless instructed to do so by Pico
technical support.

Port=1
The LPT port to use for parallel-port products. Valid port numbers are 1, 2 and 3.
Numbers 101 to 104 are reserved for Pico USB Parallel Port adapters.

Samplebar=Yes
Whether a sampling bar (trigger controls and Run/Stop button) are to be displayed at the
bottom of the screen.

SaveUncompressed=No
Whether or not files over 4 KB in size should be compressed.

SlowHoldoff=1000
When the oscilloscope is running at a second or more per scan in standard mode, this
specifies the time, in milliseconds, to wait on completion of a scan before starting the next
scan.

SpectrumFilterFactor=16
The rate at which the spectrum filter is updated. The larger the number, the slower the
update.

TraceWidth=1
The thickness of the oscilloscope trace, in pixels.
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UpdatesPerSecond=20
How often the instrument windows will be updated. For ADC-200/212/216 and PicoScope
2000/3000 series oscilloscopes, this value can be increased for better performance. For
slower products, a high update rate may slow down keyboard input and make the
computer difficult to use.

Viewbar=Yes
Whether a control bar for the active window is to be displayed at the top of the main
window.

ZeroDb=707000
The level, in microvolts, that the meter and spectrum analyser should use for zero dB.

7.4 File and clipboard formats

PSD and PSS files
The file formats for these two files are the same, except that a PSS file contains no
measurement data. Please note that PicoScope will compress files larger than 4 KB. If,
therefore, you are saving a file with the intent of importing it into another application,
ensure that you have set the SaveUncompressed flag in the .ini file to Yes.

A file is made up of a number of sections in the following format:

Header

Part 1

Part 2

Part 3

The header is 8 bytes long and contains the following information:
  Owner
  Section type
  Section number
  Number of parts

The only useful items are the section type and the number of parts. Each part is preceded
by a 32-bit byte count, which specifies the length of the remainder of the part (i.e. the
length excluding the byte count.) Most sections contain only one part but data sections
usually contain two or more.

There are four types of data section:
  Single channel fast (section type =1)
  Double channel fast (section type = 2)
  Single channel slow- standard/chart recorder modes (section type =3)
  Meter (section type = 4)

For a single-channel data block:
  Part 1 contains information about how the data was collected
  Part 2 contains an array of 2-byte ADC readings
  Part 3 contains an array of 4-byte times
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Data blocks with more than one channel are similar, but Parts 3 onwards contain data for
subsequent channels, and the last Part contains the times.

.TXT files for scope windows

Column 1 is the time, usually in microseconds or nanoseconds. Column 2 is the voltage,
in either millivolts or volts. 

If there is more than one channel, the times and voltages for channel A appear first, then
the times and voltages for channel B appear below, and so on. This is because readings
for different channels may be collected at different times.

The same format is used when pasting scope data on the clipboard. 

.TXT files for spectrum windows

Column 1 is the frequency, in Hz or kHz, and Column 2 is the power in volts or dB.

The same format is used when pasting spectrum data on the clipboard. 

7.5 Signal conditioner files

PicoScope - and other software from Pico Technology - is supplied with a set of .psc
files that contain scaling information on a wide range of sensors. The Edit custom range

dialog box offers a choice of the sensors in these files. 

You can add your own scaling information by creating additional .psc files that will be
used automatically by PicoScope. 

7.6 Autosetup

The Autosetup feature in PicoScope sets up timebase, channels and trigger
configuration automatically.  It supports all converters.  Activate it by clicking the
"lightning" button.

AutoSetup follows these rules:

The timebase will auto-range to the first enabled channel with a signal. 
If no channels have signals then the timebase will be set to the default timebase for
that converter. 
If there is a trigger enabled, the trigger channel is automatically set to the first enabled
channel with a signal. 
The trigger mode is set to Auto and the trigger delay to -10%. The trigger threshold is
set to 0mV if AC coupling is enabled or is centred between the peak values if DC
coupling is enabled. 
If there is a trigger enabled and there are no signals in any channels, the trigger is
disabled. 
The voltage range is set relative the signal on that channel. If no signal is present, it is
set to the minimum range for that channel. 
The AC/DC coupling state is not changed. 
If a channel is enabled, it will stay enabled and if it is disabled it will stay disabled. 

Autosetup can detect frequencies from 50 Hz to a quarter of the sample rate of the
scope. 
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7.7 Test menus

If you have a number of standard tests that you carry out regularly, you can add a menu
to select the settings for these tests by name. You can also use this facility to add a menu
of example files that show what particular signals look like.

To add a test menu, it is necessary to create a test menu file. The facility to create this
file is not built into PicoScope, it is necessary to use a text editor like Notepad, or a word
processor.

When the selected language is English, PicoScope looks for a test file called 
TEST044.INI. For other languages, replace the 044 with the telephone dialling code for
the required language (eg 049 for German). The test file is in the standard
Windows.INI file format. 

Simple example

A very simple file looks like this:

[General]
Menu=Examples
Path=c:

[Examples]
Noise=noise.psd
Distortion=distort.psd

The Menu line in the [General] section specifies that a sub-menu labelled Examples
should be placed on the PicoScope main menu. 

The [Examples] section says what options should appear in the Examples sub-menu.
When a menu option is selected, the specified .psd or .pss file is loaded. For example,
if you select Distortion, the computer will load a file called distort.psd from the
specified test directory (in this case, C:).

Multilayer menus

If no filename is specified, PicoScope creates a sub-menu for the option. The following
example contains two sub-menus:

[Examples]
Amplifier=
CD player=

[Amplifier]
Noise=noise.psd
Distortion=distort.psd

[CD player]
White Noise=white.psd
PSU noise=psu.psd

Documentation

You can associate each menu option with either a document of some sort, or with a topic
in a help file. PicoScope will display the specified help topic or document if you click on
the Test button on the help menu. If AutoShow is set to Yes, it will also display the
information as soon as the test menu option is selected. 

The following example shows how to do this:

[General]
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Menu=Examples
Path=c:
AutoShow=Yes
Help=exam044.hlp

[Examples]
Noise=noise.psd,10000
PSU Noise=psunoise.psd,20000,psu.hlp
Distortion=distort.psd,notepad.exe distort.txt

A numeric item after the filename indicates that PicoScope should display a help topic:
any other item is treated as a command line.

In the above example, when the Noise menu option is selected, PicoScope will load 
noise.psd, then it will display topic 10000 from the default help file (c:\exam044.hlp
).

When the PSU noise menu option is selected, PicoScope will load psunoise.psd, then
it will display topic 20000 from the specified help file (c:\psu.hlp).

When the Distortion example is selected, PicoScope will load distort.psd, then it will
run notepad.exe to display distort.txt.

In Windows 95, you can specify 'start distort.txt' and it will then start the correct
program for a .txt file.
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7.8 Glossary

AC/DC switch

The AC/DC switches for ADC-200 and PicoScope 2000 and 3000 series oscilloscopes
operate under software control, rather than manually. When you are using an ADC-200 or
PicoScope 2000 or 3000 series oscilloscope, one, two or four AC/DC combo boxes
appear on the instrument toolbar.

Note: Changing the AC/DC switch settings in one instrument window will also change the
settings in all the other instrument windows that are running.

Aliasing

When you take a set of samples from an input signal, any frequency in the input signal
which is above the Nyquist frequency (half the sampling rate) appears to be at a
frequency below the Nyquist frequency. This phenomenon is called aliasing.

For example, with a frequency of 20,000 samples per second, the Nyquist frequency is
10,000 Hz. If the input signal contains a component at 11,000 Hz, it will appear at 9,000
Hz.

It is easy to check for aliasing by changing the sampling frequency: real signals will stay
at the same frequency, whereas aliased signals will move.

It is possible to reduce the effects of aliasing by taking several readings for each sample
(oversampling), then applying a digital filter to attenuate signals above the Nyquist
frequency. Note: This is only possible when the sampling rate is well below the maximum
sampling rate at which the ADC can operate.

Alternate mode

If the event you are observing is repeated, you can use alternate mode. This enables
PicoScope to take blocks of readings alternately from one channel to the other, at full
speed.

Channel

This is for specifying from which channel to measure data.

Channel A/B

This is for specifying an input voltage range. If you select Auto, the ADC will automatically
adjust the voltage range to suit the input signal. Selecting Off will turn a channel off.

Chop mode

The computer takes a reading from one channel and then a reading from the other
channel. This is useful for events that occur only once and you wish to see the same
event in both channels. The disadvantage of chop mode is that the sampling rate on two
channels is half the sampling rate with one channel.
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dB

Decibels. The decibel is a unit of power ratio. The decibel value can be expressed as:

10 x log10 (power / power_zero_db)

If you work this out when power = power_zero_db, you will find that the dB value is zero.
As power is proportional to the square of the voltage, this formula can also be expressed
as:

20 x log10 (voltage / voltage_zero_db)

There are a number of possible values for the zero dB voltage. We have chosen to use 1
volt peak (0.707 V RMS).
Another measure is with respect to 0.776 V RMS (1 mW into 600 ohms). This is
sometimes called db(m).
See Initialisation settings for information on how to change the zero-dB level.

ETS

Equivalent Time Sampling. This facility offers a higher effective sampling rate when used
with repetitive signals, which some products support. Note: ETS should not be used for
one-shot or non-repetitive signals.

Note: ETS is used only in oscilloscope windows. When you access this function from the
trigger sample bar, some faster timebases are added to the instrument toolbar.

See under ETS on the Trigger Setup topic for more details.

FFT

Fast Fourier Transform. This is a process that converts a set of values equating to time
into a set of values equating to frequency. PicoScope uses this technique to generate the
spectrum analyser window.

Function

This specifies which function to use. The options are as follows:

  DC volts. The DC component, or average input voltage.
  AC volts. The RMS AC voltage. This excludes any DC component.
  dB. AC volts converted to dB, with respect to 0.776 V. Equivalent to dB(m).
  Frequency. Frequency of the AC component, in hertz.

Maximum frequency

This is for controlling the sampling rate of the data collected for spectrum analysis. It
determines the highest frequency that the spectrum analyser can display.

Note: The lower the maximum frequency, the longer it takes to collect enough data to
display a spectrum. At very low maximum frequencies, this may affect the response time
of your computer to keyboard input.

Range

This allows you to specify an input voltage range, or select Auto so that the oscilloscope
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will automatically adjust the voltage range to suit the input signal.

If you have defined any custom ranges, these will appear in the list of options after the
voltages.

Sampling status

This window indicates whether PicoScope is collecting data.

You can click on the Stop/Go button or press the space bar to start or stop collecting. If
the computer detects that no ADC is connected, a message will appear here. When you
plug in the ADC and turn on power (if required) the status will change to Stopped.

Stop/Go button

The Stop/Go button to the left of the sample bar has a dual purpose. When PicoScope is
collecting data, the button displays the word 'Stop.' If you click on it, data collection is
stopped. When PicoScope has stopped collecting data - because the Stop button or
some trigger event has been activated - the button displays the word 'Go.' If you click on
it, PicoScope resumes data collection.

Timebase

The timebase control allows you to adjust the value of the time interval across the
oscilloscope display.

If you select Scope timebase is time per division in the Scope Advanced Options dialog box,
the display works like a normal oscilloscope. There are ten divisions across the screen,
so the total time interval is ten times the timebase.

Trigger channel

This is for selecting the channel to be used as the trigger input.

Trigger delay

This allows you to control the time delay between the trigger event and the start of data
collection. There is a number and a time units field. You can type in a new value for the
number, or adjust its current value using the up and down arrows.

Trigger direction

Use this to select the direction in which the signal crosses the trigger event threshold.
The trigger directions are as follows:

  Rising. Triggers when the trigger channel signal rises past the trigger threshold
  Falling. Triggers when the signal falls past the threshold

Trigger mode

You use this to select the trigger mode. The trigger modes are as follows:

  None. No trigger event, so it collects and displays data continuously
  Auto. Starts collecting when a trigger event occurs or after the auto-trigger time,

whichever is sooner
  Repeat. Starts collecting only when a trigger event occurs. After displaying the data it

waits for the next trigger event
  Single. Starts collecting only when a trigger event occurs and stops after displaying the
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data
  ETS. This enables equivalent time sampling (not available with all products)

If you select None, the remaining trigger options are shaded.

Note: If you select Repeat or Single when using an oscilloscope not belonging to the
ADC-200 or PicoScope 2000 or 3000 series, PicoScope locks the computer until a trigger
event occurs. If PicoScope does become stuck, click on the Stop button in the sample
bar, then press F9 (16-bit applications) or F10 (32-bit applications) to cancel the trigger.

Trigger threshold

This shows the voltage, in mV, that the trigger channel must cross in order for a trigger
event to occur. You can type in a new value for the trigger threshold, or adjust the current
value using the up and down arrows.

Note: The trigger threshold is acted upon immediately. The minus sign on its own is not
valid: if you want a negative trigger delay, type in a number followed by the minus sign.

X multiplier

When the X multiplier is set at 1, the computer displays the collected data across the full
width of the window. If you change the value of the X multiplier to x2, the computer
magnifies the data to double its original size, and displays a scroll bar across the bottom
of the window. You use this to scroll through different portions of the data.

Note 1: You can change the Y multiplier to expand the voltage range. 
Note 2: If you set the X multiplier to a value of x10 or above, it may be worthwhile
increasing the max samples per scope trace value.
Note 3: In the XY Scope display, the X multiplier acts on the input voltage selected for the
X channel, not on the timebase.

Y multiplier

When the Y multiplier is set at 1, the computer displays the full voltage range within the
boundaries of the instrument window.

If you change the Y multiplier to x1, the computer initially displays the full voltage range,
but also displays a scroll bar. You can use this scroll bar to move the trace up or down,
away from other traces.

If you change the Y multiplier to x2, the computer displays only half of the voltage range,
but at double magnification. The scroll bar now controls which portion of the voltage
range is displayed.

Note: You can change the X multiplier to expand the time axis (or, in the XY oscilloscope
window, the horizontal voltage axis).
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Index

A
AC voltage    36

AC voltage display    11

AC/DC switch    7, 15, 16, 17

Accumulate option    70

Accumulate successive cycles    12, 57

ADC    1, 2, 30

ADC - configuring    65

ADC selection    47

ADC-100 series settings    32

ADC-11/22 settings    31

ADC-200 series settings    33

Adding a custom range    63

Adding a ruler    63

Adding a test menu    64

Aggregate cycles    41

Alarm limits    7, 43

Aliasing    9

Analog intensity    50

Application window    2

Auto setup    15

Auto trigger after    27

Autoselect 2x2 square option    13

Autoselect option    13

Autosetup    74

Axis scaling - changing    65

B
Bar graph    60

Beep on trigger    27

Blackman window    9

Block mode    7, 52

C
Changing axis scaling    65

Changing settings    65

Changing the footer on printed graphs    65

Channel settings    7, 22, 27, 31, 32, 33, 34,
35

Chart recorder    52

Chart recorder mode    7

Clipboard    3

Clipboard colour option    70

Colour settings    20, 49

Composite    1

Composite options    61

Composite window    6, 13

Composite window settings    13

Composite window toolbar    18

Composite windows or views    62

Configuring your ADC    65

Contact details    5

Converter settings    20

Converting data files to text    66

Copy as graph    22

Copy as text    22

Copy measurements    22

Coupling    33, 34

Crest factor    36

Current (Filtered)    50

Current (Unfiltered)    50

Custom range - adding    63

Custom range list    44

Custom range settings    12

Custom ranges    3, 11, 22

Customisation    3

Cycle time    36

D
Data    3

Data files - converting to text    66

DC voltage    36

DC voltage display    11

DDE    3, 70

DDS file    46

Decibels display    11

Default toolbar    15

Delay after trigger    27

Digital colour    50

Direction settings    27

Display a grid    52

Display area    2

Display axis scaling    52

Display current sampling status    19

Display datestamp in views    48

Display mode    50, 55

Display notes in views    48

Display preferences    20, 48

Display sampling bar at bottom of window  
 48

Display settings    9

Display types    7

Display view bar at top of window    48

Displaying measurements on the oscilloscope
or spectrum analyser    67
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DrDAQ settings    35

Dual slope    30

Duplicate view    22

Duty cycle    36

Dynamic Data Exchange    70

E
Early triggering option    70

Earth    3

Edit custom range    45

Edit DrDAQ custom range    46

Edit menu    22

Equivalent Time Sampling    7

Error action    41

Error limits    7

ETS    7

ETS mode    68

ETS oversample    52

ETS update speed    52

Exit    20

Exporting data    3

Exporting to a spreadsheet    67

Exporting to a word processor    67

F
Falling rate    36

Falltime    36

Fast Fourier Transform    9

FFT    9, 37

File and clipboard formats    73

File formats    3

File menu    20

Footer    65

Footnote option    70

Frequency    36

Frequency display    11

Function    17

G
Gain    37

Grid    7

Grid settings    9, 12

Ground    3

H
Harmonics    37

Help menu    25

Holdoff option    70

Horizontal zoom    15, 17

I
IMD    37

Infinite persistence    50

Initialisation settings    70

Instrument    6

Instrument toolbar    15

Instrument window    1, 2, 7, 9, 11, 12, 13

Instrument window - opening    66

Interference    3

K
Keyboard shortcuts    25

L
Legal information    4

M
Main toolbar    2

Max harmonic for THD    41

Max samples per scope trace    52

Maximum    36

Maximum displays per second    48

Maximum frequency    16

Maximum frequency settings    9

Measurement details    36, 43

Measurement facilities    36

Measurement list    22, 40

Measurement options    41

Measurements    1, 7, 22

Measurements - displaying    67

Menus    20, 24, 25

Merge    20

Meter    1, 6

Meter button    15

Meter options    11, 58

Meter parameter    60

Meter parameter list    59

Meter toolbar    17

Meter window    11

Minimum    36

Multiplier setup    31, 35
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N
New    20

New composite    24

New meter    24

New scope    24

New spectrum    24

New XY scope    24

Notes    29

Number of spectrum bands    55

O
Offset - removing    68

Offset null    22

One above another option    13, 61

Open    20

Open next    20

Open previous    20

Opening an instrument window or view    66

Options    22

Oscilloscope    1, 6

Oscilloscope - configuring    65

Oscilloscope button    15

Oscilloscope measurement facilities    36

Oscilloscope settings    7, 14

Oscilloscope timebase    54

Oscilloscope toolbar    7, 15

Oscilloscope window    7

Overlay    61

Overlay views option    13

Oversampling options    70

Overvoltage    15

Overvoltage warning    7, 12

P
PC oscilloscope    7

Peak to peak    36

Persistence    50

Phase offset option    70

PicoScope    1

PicoScope 2000/3000 Series settings    34

Print    20

Printed graphs - changing footer    65

Printer port selection    47

Printing    29

Printing the contents of a window    67

Probe settings    22

Probes    44, 68

Product description    1

Project notes    29

PSC files    45

PSD file format    73

PSS file    20

PSS file format    73

psw.ini    70

Pulse width    36

R
Removing a ruler    64

Removing an offset    68

Repositioning a ruler    64

Risetime    36

Rising rate    36

Ruler - adding    63

Ruler - removing    64

Ruler - repositioning    64

Ruler settings    9, 12

Rulers    7

S
Safety    3

Sampling and trigger toolbar    2, 19

Sampling status    19

Saturation    50

Save    20

Save As...    20

Save on trigger    27

Save on trigger option    14, 70

Save settings    2, 20

Save uncompressed option    70

Scaling    65

Scan time    37

Scope advanced options    52

Scope options    50

Scope timebase    54

Scope timebase is time per division    52

Selecting x10 probes    68

Set trigger    19

Settings    27

Settings - changing    65

Setup    3, 20

SFDR    37

Shortcuts (keyboard)    25

Side by side option    13, 61

Signal conditioner    45

Signal conditioner files    74

Signal generator    30
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SINAD    37

Slow sampling    7, 52

SNR    37

Spectrum analyser    1, 6

Spectrum analyser button    15

Spectrum analyser measurement facilities  
 37

Spectrum analyser timebase    56

Spectrum analyser toolbar    9, 16

Spectrum analyser window    9

Spectrum options    9, 14, 55

Spreadsheet - exporting to    67

Standard tests    3

Start and stop sampler    19

Start/stop sampling    19

Stop after trigger    14, 27

Sweep mode    30

Switching to ETS mode    68

T
Technical reference    70

Test menu - adding    64

Test menus    75

THD    37

Threshold    27

Time at O ruler    36

Time at X ruler    36

Time per division option    70

Time per scan    58

Timebase    15, 17, 54

Timebase is per division    54

Timebase settings    7, 9, 12, 22

Trigger channel    19

Trigger delay    19

Trigger direction    19

Trigger enabled    27

Trigger event    27

Trigger mode    19

Trigger setup    14, 22, 27

Trigger threshold    19

Two by two    61

TXT file format    73

U
Update rate option    70

Use ETS    27

User interface    2

V
View - opening    66

View menu    24

Voltage at O ruler    36

Voltage at X ruler    36

Voltage range    17

Voltage range settings    7, 9, 12

Voltage range setup    31, 32, 33, 34, 35

W
What is PicoScope?    1

win.ini    70

Window menu    6, 25

Windowing    9

Windows    6

meter    11

oscilloscope    7

spectrum analyser    9

Word processor - exporting to    67

X
X axis scaling    9

X multiplier    15, 16, 18

X multiplier settings    54

X scrolling    61

XY oscilloscope    1, 6

XY oscilloscope options    12, 57

XY oscilloscope timebase    58

XY oscilloscope toolbar    12, 17

XY oscilloscope window    12

Y
Y axis multiplier setup    32, 33, 34

Y axis scaling    9

Y multiplier    15, 17, 18

Y scrolling    61

Z
Zero dB level    70

Zoom - horizontal    15, 17
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